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Foreword

When I wrote Adobe Premiere Pro 2.0 Studio Techniques back in 2006, the land-
scape of nonlinear editing, not to mention the technology in the film and 
video business, was nothing like it is today. There were few HD video cameras, 
formats like DigiBeta and DVCam were still considered standard and accept-
able delivery formats, and HDV was a thing. There was little discussion of 4k, 
and RED was the color of the Adobe logo. It’s amazing to reflect on how much 
has changed in the last seven years and mostly all for the better and benefit of 
the users and artists.

Ironically, the end of 2006 marked a major career turning point for me as I 
partnered with my friends Mike “Mouse” McCoy and Scott Waugh as the CTO 
and head of postproduction for our company, Bandito Brothers. 

In a very real way, the edited component of Bandito Brothers was born and 
raised in Adobe Premiere Pro. The techniques I described in the previous 
volumes were used day in and day out as part of our post workflow. Having 
learned the application inside and out, we created and ran an efficient and 
contained postproduction pipeline that gave us complete control of all the 
projects we edited. We mixed and matched every format we could get our 
hands on, and developed a language and style that represented who we were, 
which now serves as the visual foundation of who we are. 

While we remain deep in technology and the latest and greatest tools, Adobe 
Premiere Pro is still an integral part of our postproduction pipeline. With the 
recent Creative Cloud version of Adobe Premiere Pro, the buzz around the in-
dustry is no longer about Avid or Final Cut Pro but finally about our old friend 
Adobe Premiere Pro.

The principal idea of the Studio Technique series is to thrust you deeper into 
ideas and advanced methods of working with the tools. Lessons guide you 
down a path to get to a destination. But along the way you learn a bunch 
of tricks that make you more proficient in not only the end result, but in 
the details of getting there—quicker methods to complete tasks, shortcuts, 
workflow tips, and ways to make your content look better and your flow be 
more efficient. 

When I wrote the previous volumes of this series, it was just me and my own 
collective experience. With this latest volume, readers now have the luxury of 
learning from a bevy of experts and professionals to create an even more dy-
namic and broader range of techniques that are essential to honing your skills.
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At the end of the day, the tool does not make the artist. The work is made 
meaningful by the passion that goes into it and the content that carries it. Hon-
ing your skills and perfecting your craft enables you to get closer to creating 
exactly what is in your head to the best of your abilities. For me, becoming an 
expert in Adobe Premiere Pro was a means to fulfilling a lifelong dream of 
making movies, telling stories, and being a part of something I believed in. I 
trust that this latest volume will ensure you safe travel along your own journey 
and help you understand Adobe Premiere Pro in new and more powerful ways. 
It’s exciting when your old friend gets better with age.

—Jacob Rosenberg

Jacob Rosenberg is a Director and the CTO of Bandito Brothers in Culver City, 
California. His directorial debut film, Waiting for Lightning,  

was released in 2012 by Samuel Goldwyn Films.
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Introduction
Jeff I. Greenberg

On This Rare Occasion Please Read the Introduction

If you’ve picked up this book, we want to encourage you to look through its 
contents and discover the techniques that will put you further on the path to 
becoming an advanced user of Adobe Premiere Pro. 

In this Studio Techniques book, it’s assumed you’ve used Adobe Premiere Pro 
and that you’re no longer a novice. Maybe you’ve never used every Adobe tool, 
but you’ve acquired footage and edited and delivered output. We expect that 
some of you have read the Adobe Premiere Pro Classroom in a Book or equivalent, 
and others may have been using Adobe Premiere Pro for years.

We also assume that you understand the concepts of real-world delivery 
schedules, clients who are unreasonably demanding, and headache-producing 
market pressures. Perhaps you even have friends and family that you’re able to 
spend time with occasionally.

The pressures that an editor is under today seem much greater than a decade 
ago when concepts such as “offline editor only,” “picture lock,” and a reason-
able delivery schedule ruled the day. Nowadays, footage is being thrown at 
the busy editor from every direction, clients often don’t make up their minds 
(although they truly never have!), and there’s constant pressure to always be 
upgrading software and hardware.

This book gives you the advanced tips and techniques that can make your work-
flow smoother and your editing faster. It includes techniques that could literally 
take months or years to discover on your own.

What makes this book extraordinary is that it’s not a “how to” use Adobe 
Premiere Pro book; rather, it dives into practical, real-world techniques used 
by editors working in the trenches with the software every day and teaching 
others to use it as well. Not only do the four authors who wrote this book 
earn their living as editors working day-to-day in film, television, and video 
postproduction, but they also have been “blessed” by Adobe and made Adobe 
Premiere Pro Master Instructors. This gives them the distinction of teaching 
instructors and Adobe Certified Experts on how to teach Adobe Premiere Pro 
to others in the Adobe way.
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Hitting a Moving Target

One of the best features of Adobe Creative Cloud is the flexibility it gives 
Adobe to roll out an update, which is fantastic as a user. But it’s not so great for 
an author, especially when a chapter has been finished and put to bed. Major 
changes can wreak havoc with your sanity and sleeping patterns when you wake 
up in the middle of the night screaming because much of what you’ve written 
must be revised. This book has been written as much as possible in a general 
way—not specifically tied to a particular version. And as significant updates 
that affect the content occur, they’ll be addressed with errata on the web page 
with the downloadable files (see “A Note About Downloadable Content”).

A Note About Overlap

All of the authors had quite a bit of freedom to write about concepts they felt 
were important to the techniques they were writing about, even if there was 
some overlap. For you, the advantage of this overlap is that it can help you 
understand the “why” behind the techniques—sometimes from multiple points 
of view. For example, it’s valuable to remap the keyboard. Hearing the reason 
for it from an editorial point of view is different than hearing it from a color-
ist’s point of view.

How This Book Works

For the most part, each chapter is readable in isolation. When necessary, other 
relevant chapters are referenced. While trying to maintain a similar style, 
authors were given the liberty to write in their own voice. Multiple authors 
provide the flexibility for different viewpoints in editorial and a faster writing 
process. Any of these authors are skilled enough to have written the entire text!

We offer you loads of gems throughout the book in Tips (something cool) 
and Notes (something to watch out for), but many are also scattered through-
out the text. 

You’ll know some of the techniques discussed in this book, but I can assure you 
that you won’t know all of them. Yes, in some cases you might be able to jump 
through a chapter quickly, but if you’re weak in a given chapter’s topic, we 
highly recommend a deep read.  The following sections provide a brief over-
view on each chapter.

.. Chapter 1: “Editing in Adobe Premiere Pro” discusses some of the specific 
functionality that makes Adobe’s nonlinear editor nimble and quick in this 
all-too-soon to be 4k world. Topics include what makes Adobe Premiere Pro 
so special, and what differentiates a consumer camera and a cinema camera. 
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The chapter also explains that you should give special attention to hardware 
system design, performance monitoring, and the order in which you may 
want to approach using and learning the tools in Adobe Creative Cloud.

.. Chapter 2: “Setup and Organizing” offers wonderful tips on how to best set 
up Adobe Premiere Pro and your media prior to starting a project. If you cre-
ate and build a Common Media folder with a preconfigured project, you’ll be 
able to start new projects faster that are optimized to your system. You’ll learn 
to adjust preferences to improve working with Adobe Premiere Pro as well as 
learn how to set up caches throughout Adobe Creative Cloud applications. 
And if you’re a narrative- or transcript-based editor, be sure to check out the 
section “Speech and Script Technologies” at the end of the chapter.

.. Chapter 3: In “Editing Techniques,” Christine Steele gives you great insights on 
how to edit smarter and faster with some power techniques. And just because 
you’ve been editing for years doesn’t mean you should skip the “Editing Es-
sentials” section. The techniques provided for three-point editing and replace 
editing could change the way you work! If trimming mystifies you, there are 
loads of details about the different ways you can trim efficiently. If you’re a 
razor blade and delete editor, this information will open up new ways to work.

.. Chapter 4: In “Professional Audio,” Luisa Winters helps demystify the audio 
workflow process by describing smart techniques in order of process—from 
adjusting prior to the edit to using sophisticated submixing and audio FX. 
She also explains the methods of performing noise reduction and fixing 
clipped audio in Adobe Audition.

.. Chapter 5: Tim Kolb takes a very practical approach to effects in “Advanced 
Compositing and Effects,” showing you how you can think “outside the 
box.” The techniques he shows are very much about the type of play you 
often do to get an effect to work. He starts with some simple elements and 
builds on them to create more complex effects.

.. Chapter 6: “Color Correction” helps you understand the way light and 
video scopes work. Many examples are provided, and also included is a gen-
eralized recipe on which order to adjust the Three-Way Color Corrector. 
Shot matching and Secondaries are explored as well to help you do every-
thing possible directly within Adobe Premiere Pro. Extend your knowledge 
outside of Adobe Premiere Pro by moving your material to Adobe Speed-
Grade and back with this quick usable crash course on its interface. 

.. Chapter 7: “Exporting Strategies” is about unlocking some of the cool 
techniques in Adobe Premiere Pro and Adobe Media Encoder. Some great 
presets are built right in the chapter, which should help you get an idea of 
what to adjust when you want to tweak the presets in both tools. 
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.. Chapter 8: Workflow is always difficult to write about because no two work-
flows are identical. And if you’re reading about a workflow that doesn’t 
apply to you, it can be difficult to find what’s important. In “Workflow Man-
agement,” Tim Kolb approaches workflow by giving you specific techniques 
that aren’t obvious, which are guided by his years of experience working 
with Adobe Premiere Pro.

What’s Not in This Book

We tried to include as much varied content as we could that represented the 
other video-related tools in Adobe Creative Cloud. But this is mostly an Adobe 
Premiere Pro book. However, Adobe Premiere Pro doesn’t exist in a vacuum, 
so we included the key details that are necessary to know about the other 
video-based applications.

Here are some items that you won’t find in the book:

.. No tape-based techniques. We know you’re saying, “But I still use tape.” 
We’re not in any way, shape, or form saying you shouldn’t use tape. In fact, 
the authors romantically wish they were still using tape.

Most of the situations we’ve been in in the last five years or so have been 
tapeless worlds, which is the reason we didn’t include any material about 
tape-based work.

.. Only the key Adobe Creative Cloud applications. Yes, we’re huge fans of 
the entire Adobe tool set, but although tools like Adobe Illustrator, Adobe 
Bridge, Adobe InDesign, and Adobe Dreamweaver have loads of value, 
they’re not linchpins of video editing. 

A Note About Downloadable Content

Not every chapter has media. Chapters 1, 2, 7, and 8 do not contain projects. 
Chapter 2 has a script and clip to use with the speech recognition section, and 
a template of folders to help you organize your own projects. Chapters 3, 4, 5, 
and 6 have complete projects and media that you can download that work with 
specific examples from the text. Chapter 6 also has two broadcast legal looks to 
use in Adobe Premiere Pro with the Lumetri filter. Chapter 7 has a surprise! I’ve 
build the presets from the chapter for download as well.

Throughout this book, you’ll see examples of scenes that are used to demon-
strate various concepts and techniques. The downloadable content includes a 
wide variety of corresponding media clips that you can use as a playground for 
experimenting with the techniques discussed. 



xiixii

To access the Project and Lesson files, please follow these steps.

	1.	 On a Mac or Windows computer, go to www.peachpit.com/redeem and 
enter this code: 23AA613BB0A2.

	2.	 If you do not have a Peachpit.com account, you will be prompted to cre-
ate one.

	3.	 The download files will be listed in the Lesson & Update Files tab on your 
Account page.

	4.	 Click the file links to download them to your computer.

This process may take some time to complete, depending on the speed of your 
computer and Internet connection.

Note that if updates to this book are posted, those updates will also appear on 
your Account page at www.peachpit.com.

Special Thanks

As the lead author, the only real power I get to abuse is lavishing thanks upon 
others. Without these people, this book would have never have happened. 
There are so many people to thank that even narrowing down the number to 
what you see here was difficult.

This is an indulgence, but here is a personal note from me (Jeff) to you the 
reader: If you find anything in this book that makes your life easier (and there 
should be lots!) and if you ever meet any of these wonderful people, take a 
moment and let them know! Writing, like editing, is done in a small room with 
what often feels like only negative feedback.

My Co-authors

This book has been a massive effort. During the writing major life forces were 
at work, which make book writing all that more difficult. Let me start by thank-
ing each of my co-authors and their families. I’m sorry I had to take so much of 
their time:

Christine Steele. When Christine signed on to write about editing, I tried to 
warn her about how much work goes into writing a chapter. She amazingly 
managed to fit in the writing in addition to a new project she’s editing for PBS. 

Luisa Winters. Luisa was a superstar, writing a great chapter on audio and 
turning it around remarkably fast during her busy schedule. I’ve worked with 

http://www.peachpit.com/redeem
http://www.peachpit.com


xiiixiii

Luisa for years, so the result was no surprise given her knowledge base and her 
professional skills. 

Tim Kolb. Tim contributed so much technical knowledge to the book. His 
chapter on workflow really ties down some small nuances that I’ve never seen 
before in print.

Maxim Jago. Maxim is the unofficial co-author of this book. He agreed to do 
the technical edit, and luckily for us he went far and beyond. Maxim even 
wrote several sections in a couple of chapters. I absolutely couldn’t have shep-
herded this book without my friend Maxim on board. 

Shawn Lamb. Thank you for your extra work early on in the audio chapter.

Peachpit Press

Relationships between authors and publishers are always rocky. Deadlines are 
always in the front of the publisher’s mind and keep authors awake at night. 
My thanks go out to the following Peachpit crew:

Karyn Johnson. Karyn’s cool head prevailed, especially toward the end of the 
deadline when the doors inevitably come off the machine.

Rebecca Gulick. I would not have taken this role and the book wouldn’t have 
happened if it wasn’t for Rebecca. She was a rock for me, especially in the early 
days of the book. Thank you so much!

Anne Marie Walker. This is the third book you’ve copyedited for me. I hope 
I’m not the only author ever to tell you this: I’m stunned at how much better 
my writing sounds because of your deft hand. 

Adobe

And then there are those people inside the walls. Thanks to all those who work 
at Adobe and help fools like me rave about what I love (and on occasion what 
drives me crazy!):

Michelle Gallina. I know you’re now off in Adobe After Effects land, but this 
book and the Master Trainer program wouldn’t exist without you! You are my 
favorite person at Adobe, and I am indebted to you for your help and support.

David Helmly. So many times there was a minor question or some obscure 
switch I needed help with, and time after time you’ve been there for me. 

Mitch Wood. I should print and frame the massive email of answers you’ve 
helped with and send you a photo! Thank you so much.
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Additionally, the Adobe people that I absolutely, positively have to thank for 
all their support include Bill Roberts, Al Mooney, Meagan Keane, Steve Ford, 
Patrick Palmer, Dennis Radeke, Todd Kopriva, Kevin Monahan, Jason Levine, 
Colin Smith, Anita Engleman, Ellen Wixted, and Leonard Rosenthol.

Friends and Colleagues

Of course, I’d like to thank the rest of the Master instructors as well, particu-
larly my friends Abba Shapiro and Rich Harrington who helped Adobe start 
the program.

William Robinson (Robbie) Carman for your wisdom, guidance, and sanity 
(yeah, Catherine too).

Stu Bass for a quick insight into how his episodic TV projects are set up.

Ben Kozuch and Jeff Rothberg, and everyone at FMCTraining.

Those people who are near and dear to my soul: Dorn Hetzel, Gabeba Bader-
oon, Yossy Tessone, Jack Reilly, Jeff and Jen Smith, Jeff and Holly Preston, and 
Rich Frumer.

My Family

Isn’t it terrible that family comes last all too often?

First, to Amy, my wife: I love you so very much. You’ve been my sanity and my 
beacon of hope at some downtimes while cranking out this book. I hear you 
loud and clear about publishing and deadlines.

To my daughter Sophia, although you’re too young to read this, later in life 
you’ll laugh as you see photos of you hidden in this book. Dada loves you.

It’s important that I mention of course my close family: Scott, Rachelle, Mor-
gan, and Maddox; Al and Dee; Roger, Elanna, Jesse, Juillette, and Gabrielle; 
Steven, Avra, Jake, Sam, and Nate; Charles and Amy. Now you’ll have to own a 
copy of the book. 
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...the visuals and the audio have to be of a certain 
quality before I start to get excited about the thing.

—Hans Zimmer

Professional Audio

In video and film, it’s been said that audio is the most im-
portant thing to get right, and I agree with that statement. 
In fact, in the old days of silent movies, the movie theater 
would hire a professional musician to improvise and live 
perform a score while the movie was playing. Even then, 
moviemakers and theater owners understood the power of 
audio when viewing a feature film. Audio has the power to 
change how you feel about a character, the power to affect 
your mood, and definitely the power to change a mere 
adventure into an epic story.

However, I find that most people in my classes lack basic 
audio knowledge and the know-how to create a good, solid 
audio mix of their work. In many cases, even good and 
experienced editors have never seen an audio engineer 
at work, and have no idea about how to start. So, they’ll 
experiment with different volume levels and effects, trying 
to get a good mix and balanced audio. But without basic 
knowledge of what to do, they usually fail. 

Most people perceive video as being of lower quality if the 
audio is low quality, which means that you can improve 
your production quality by improving your audio quality. 

Although this book is about postproduction, keep in mind 
that maintaining good quality audio in the production pro-
cess will be invaluable in the postproduction stage. “Fixing 
audio in post” is unrealistic and will rarely yield good results. 

This chapter will help you start to generate great audio in 
your program. Because you don’t always get to work with 
perfect audio, this chapter also features a section on how 
to fix common audio problems using Adobe Premiere Pro 
and Adobe Audition CC. From setting up your working en-
vironment to adjusting levels to adding effects, you’ll work 
with audio just like the pros do.

This chapter’s project files are 
available for download. Please 
see  “A note about downloadable 
content” in the Introduction of 
this book.
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Listening Environment

The importance of your listening environment cannot be 
overstated. Two tools will determine how you treat your au-
dio: your ears and the equipment that gets the sounds to them. 

Your Ears 

Some people are born with natural abilities that make their 
perception of audio and therefore their processing tasks 
very easy for them; others are not. Just like any other skill, 
you can train your ears to detect the nuances of audio. You 
can also train your ears to know what to do to adjust your 
audio to get the desired results. Perceiving good audio 
does not happen overnight; sometimes it takes years of 
training. I recommend constantly comparing your work to 
the original recording (unprocessed) and to recordings 
that you know are good and that you like. Start training 
your ears to hear what you’ve been missing!

Equipment and Your Audio Setup 

Having sounds get to your ears in the most accurate way 
possible is essential to the successful mixing and master-
ing of your program. Needless to say, you should work in a 
quiet room. But besides quiet, you can use certain equip-
ment and do many things to improve the way you listen to 
your audio in your editing space. Some of them are costly 
(a pair of quality monitor speakers will set you back a few 
dollars), and some don’t cost a penny: 

.. Quality of speakers. Get the best speakers you can af-
ford. A wide variety of models and sizes (and prices) are 
available. Educate yourself as to what the best models 
and sizes are for your room and your work (speaker 
manufacturer websites are an excellent source of infor-
mation). Your speakers don’t have to necessarily be huge 
and or extremely expensive. They just need to have a 
decent response to the signal that is being fed to them. If 
possible, try to use speakers in two different sizes: larger 
ones (not necessarily big; mine are bookshelf size) and 
smaller ones so you can compare what your program will 
sound like on two different systems. Make sure that the 
same output from your system feeds both pairs.

During production you need to get 
the strongest audio signal possible 
without it being too loud. You also 
need the noise in the environment 
to be as negligible as possible. 
This ratio of desired audio versus 
noise is known as signal-to-noise 
ratio. The idea is to have a strong 
“good” signal and a weak noise 
level. One of the techniques that 
you should use is to decrease the 
distance between the source of 
audio (instrument, voice, etc.) and 
the microphone, thereby decreas-
ing the levels of noise. (Micro-
phone placement and recording 
techniques are beyond the scope of 
this book.)
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.. Wall material. Various materials will have distinct sound 
absorption properties. One side of the room may be 
brighter than the other, and your mix will suffer. If is 
not that difficult and not very costly, make sure all of 
your walls use the same type of absorption material 
(foam, curtains, Sheetrock, etc.).

.. Position the speakers. Assuming you have decent speak-
ers, follow these guidelines for the best positioning: 

.. Try to place yourself in the middle of the speakers. 
They should be at the same distance on the left and 
on the right (the “sweet spot”) (Figure 4.1). If they 
are small, bookshelf-type speakers, position them 
between three and four feet from your head. The 
size and position of the speaker is referred to as a 
near-field monitor, because they are near the listener 
and therefore are minimizing the room’s influence 
on the audio waveforms.

.. Ensure that some space is between the speaker and 
the wall. This will prevent the wall reflection from 
distorting how the audio gets to you.

.. Avoid placing speakers in the corners of the room. 
All of your walls reflect sound waves, so your ears will 
receive audio that is not quite accurate if your speak-
ers are in the corners of the room. Some extra reverb 
or distortion may be added, which will cause you to 
overcompensate and deliver a faulty mix or imple-
mentation of effects.

Figure 4.1  Position your speakers so 
you’re in the “sweet spot,” prefer-
ably in the center of the room away 
from corners.

When used in reference to sound, 
“brightness” indicates the amount 
of high frequency content. Bright 
sounds contain more high frequen-
cies, and dark sounds more low 
frequencies. In music it also refers to 
the speed of the beat and the key 
signature used in composing.
	 On the other hand, “muddy” 
is a demeaning term for sounds 
that have a lot of low-to-mid 
frequency content in them. These 
sounds lack clarity, because it 
is hard to distinguish different 
instruments and voices.
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.. Speaker height. Consult the manufacturer for the 
correct speaker height. But sometimes all you need 
to do is place the speakers at ear level. You may need 
to purchase a pair of short pedestals from a local pro-
audio distributor to achieve optimal elevation.

.. Listen to good recordings. After you’ve placed your 
speakers correctly, listen to tracks that you know well 
and know are mastered correctly. Try to match the 
genre of the tracks. For example, if you are mixing 
audio for a commercial, listen to a commercial that you 
like and compare your mix with the commercial. You 
can then judge how the speakers sound. Pay close atten-
tion to the evenness of the audio, and make sure that 
the audio is balanced in the left and right channels. 
Make adjustments to the speakers if needed.

.. Speaker volume. Play tone through the speakers and 
adjust the volume until the level is comfortable, as if 
someone is speaking normally to you in the room (do 
this for both sets of speakers, if it applies). You can find 
tone by choosing File > New > Bars and Tone or File > 
New > HD Bars and Tone. Thereafter, do not adjust the 
level of the speakers (or of your computer’s audio). If 
you alter the speakers’ volume, you’ll throw off your 
sense of level and never be sure about the levels of 
your program.

.. Headphones. Sometimes, you’ll need to keep your 
sound volume to a minimum, forcing you to wear head-
phones. Headphones have both good and bad qualities 
to them. 

If you combine a set of high-quality, professional 
headphones with a clean amplification system, you can 
get the most accurate and uncolored sound content. 
You won’t need to consider room acoustics or other 
problems because when you rotate your head, the 
headphones will rotate with you, which means that no 
matter what you will always be in the “sweet spot.”

There are also negative aspects to wearing headphones:

.. Your ears get tired more easily. Most earphones are 
uncomfortable, and you tend to raise the audio level.
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.. Frequency response varies. The frequency response 
of the headphones can be quite different from that of 
loudspeakers, so you will get a false sense of what the 
mix sounds like. You might overcompensate with vari-
ous forms of sound treatment like EQ, reverberation, 
and so on.

.. Waveform refers to waves. Sound moves in waves. Low-
er tones, particularly deeper/bass tones, have a wave 
that can be as long as six feet, making them difficult to 
truly represent in headphones.

Adobe Premiere Pro’s Workspace

As you know, you can change Adobe Premiere Pro’s work-
space to suit your needs. I usually change the workspace 
when working with audio because doing so places the 
panels that I use the most in a place that I can easily find. 
Changing workspaces is easy, and Adobe Premiere Pro 
ships with predesigned workspaces that are very conve-
nient. The one I use for audio editing is the Audio work-
space. To access this workspace, choose Window > Work-
space > Audio (Figure 4.2).

Gain and Levels

Both gain and levels refer to the loudness of the audio. 
However, gain is the input level of the clips and volume is 
the output. In recording audio, gain is the first control that 
the microphone signal goes through in a mixer while levels 
are adjusted after that. 

In Adobe Premiere Pro, we adjust the gain before doing 
anything else to the clip, and then individually adjust the 
different levels of the clips so they match throughout the 
program (Figure 4.3 and Figure 4.4).

Figure 4.2  Adobe Premiere Pro lets 
you change your workspace to suit 
your audio needs.
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Figure 4.3  Audio levels before being processed.

Figure 4.4  Audio levels after being normalized to -12dB.

Why should we worry about the loudness of the clips 
matching? Because it is important to establish audio conti-
nuity in your work. You should not have a portion of your 
program be disproportionally louder than the rest; it will 
cause confusion to the viewer and your message will not be 
as clear to them. Most viewers (listeners) will expect some 
kind of evenness of the audio levels in the program. Of 
course, there are exceptions. Sometimes audio levels are 
used to produce an emotional response. 

Unless there is a really good reason for not doing so, our 
audio levels should be even throughout our program. 
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Adjusting Gain in the Project Panel

Before you add clips to the Timeline, you should start do-
ing some pre-mixing. This is easy to do, and it will save you 
time. Most of the audio that you will get in your project will 
come in at a level that is not ideal. Music, for example, usu-
ally comes in too loud, so it will definitely save you time if 
these elements are already at a better level before you add 
the clip to the Timeline.

What I do is select all of my foreground audio (voice-over 
or dialogue) and adjust the gain of all of these clips at the 
same time, and then select the background audio (music 
and Foleys) and do the same. To adjust this gain, I select 
the clips first and then press G to open a dialog that I use 
to adjust my clips. I usually set background audio elements 
to an average of -22dB (or so) and foreground elements to 
an average of -12dB with nothing peaking above -6dB.

The process is as follows.

	1.	 Select multiple clips from the Project panel.

	2.	 Choose Clip > Audio Options > Audio Gain. In the Au-
dio Gain panel that appears, adjust the gain of multiple 
clips using one of these four methods:

.. Set Gain to

.. Adjust Gain by

.. Normalize Max Peak to

.. Normalize All Peaks to

Set Gain to

The Set Gain to adjustment affects the net amount of gain 
by which you are adjusting the clip. You can increase or 
decrease gain by as much as 96dB. 

Adjust Gain by 

The Adjust Gain by option is similar to the Set Gain to 
option, but it allows you to add or decrease the net gain 
amount by incremental amounts. As you enter amounts, 
the Set Gain to amount automatically adjusts. Set Gain to is 
absolute, but Adjust Gain by is incremental, meaning that if 
you adjust it twice by 2dB, you will get an increment of 4dB.

Keep an eye on the Peak Amplitude 
measurement at the bottom of 
the Audio Gain window. It displays 
the peak amplitude in a clip before 
gain has been applied. If the Peak 
Amplitude value is -12dB, theo-
retically you can add 12dB of gain. 
However, this will give you a peak 
value that is way too loud. Use this 
value as a guide, not as a setting 
suggestion (a good reference 
level for broadcast is -12dB with a 
dynamic range [DR] of 6dB).
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Normalize Max Peak to

When you apply the Normalize Max Peak to a single clip, 
the highest peak in the clip is normalized to peak at the 
decibel level you enter, effectively increasing or decreas-
ing the gain of the entire clip. When you apply this option 
to a group of selected clips, all clips are normalized by the 
same amount of gain so that the highest peak across all the 
selected clips peaks at the decibel level you enter. In essence, 
this option will treat all the clips as if they were just one clip, 
and the level of the loudest clip will be used to normalize all 
three of them. The level of all three will be adjusted by the 
same amount regardless of how soft one of the clips may be.

Normalize All Peaks to

When multiple clips are selected, the Normalize All Peaks 
to gain option normalizes the peak of each clip to the deci-
bel value you enter. Each clip will receive its own setting 
(Figure 4.5 and Figure 4.6).

Before

Before

After

After

Figure 4.6  Using either Normalize 
Max Peak to or Normalize All Peaks to 
will yield different results.

Figure 4.5  Normalize Max Peak to treats all of the 
clip’s volumes as if they were just one clip. Adobe 
Premiere Pro will not take into consideration that 
they are separate clips and will adjust all of them by 
the same value.
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Normalization in action

To see and hear the difference between different normal-
ization methods, open Chapter04_Audio.prproj, and then 
open the sequence named Normalize. This sequence con-
tains three groups of clips. The first group has no process-
ing, the second group uses Normalize Max Peak to, and 
the third group uses Normalize All Peaks to. The voice-
over (VO) track was normalized to -12dB, the music track 
to -18dB, and all other audio to -22dB. The difference is 
not huge, but you can definitely hear it.

Experiment with this sequence by following these steps.

	1.	 Select one of the clips in the Timeline (sequence 
Normalize).

	2.	 Press G or choose Clip > Audio Options > Audio Gain 
(Figure 4.7).

	3.	 Choose any of the options in the dialog and listen to 
the clip.

	4.	 Choose Edit > Undo or press Command+Z (Ctrl+Z).

	5.	 Apply a different normalization choice and listen to the 
clip again.

	6.	 Repeat steps 4 and 5 until it becomes apparent what 
the different options do. 

Adjusting Gain on the Timeline

Adjusting gain on the Timeline is as simple as right-clicking 
on the audio clip and choosing Audio Gain to launch the 
Audio Gain panel (or press G). You’ll be presented with the 
same four choices described earlier. You can also choose 
Clip > Audio Options > Audio Gain as described earlier.

Timeline Interface

Making Timeline adjustments doesn’t add functional-
ity that isn’t available elsewhere in Adobe Premiere Pro. 
But putting additional meters and buttons directly on the 
Timeline makes it easier to tweak and monitor audio set-
tings at any stage in the editing and mixing process. In this 

Figure 4.7  You also access the Audio Gain panel 
by choosing Clip > Audio Options > Audio Gain (or 
press G).

Useful Audio Terms

Here are some definitions of terms you’ll use often:
.. Decibels (dBs). Units used to measure the 

intensity of sound: 0dB is near silence; 10dB 
is 10 times as loud; 20dB is 100 times as loud; 
30dB is 1000 times as loud; and so on.

.. Audio normalizing. Is the process of chang-
ing the overall volume of an audio clip so that 
you reach (and don’t pass) a target level. I 
usually normalize spoken audio to -6dB and 
background music to -18dB.

.. Peak amplitude. Is the maximum absolute 
value of the signal. This is the loudest that it 
will be.

.. LUFS (Loudness Units relative to digital 
Full Scale). The European Broadcast Union 
(EBU) uses the term LUFS. These are absolute 
units used to measure audio levels. The 
loudness target level could be -23 LUFS. In 
conjunction with this they use Loudness 
Units (LU). LUs are used to show relative level 
changes (-23 LUFS is 2 LUs lower than -21 
LUFS). One unit of LUFS equals one decibel. 

.. Dynamic range (DR). Is the difference 
between the loudest and the quietest part 
of your audio, and is measured in decibels. 
Depending on which genre of audio you’re 
working with, you’ll need to have a wider or 
narrower DR, so keep this in mind. Classical 
music, for example, will have a much wider DR 
than Pop or Rock.
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section I’ll discuss expanding the tracks, adding buttons to 
the track header, and keyframing.

Expand Audio Track

The first helpful customization when you’re working with 
audio is the ability to expand the audio track to show the 
audio waveforms. You need a visual representation of the 
peaks and valleys of your audio clips, and displaying the 
waveforms is the easiest way to accomplish that. 

New in Adobe Premiere Pro CC is the ability to save this 
expanded view as a preset. This preset is especially useful 
when you’re adding keyframes, searching for the start or 
end of dialogue, or finding unwanted sounds that were re-
corded. To save the waveform view as a preset, simply click 
the wrench icon  at the top of your Timeline and choose 
Save Preset (Figure 4.8).

Give the preset a name you’ll remember, and you’re done! 
To recall your preset, choose it from the same menu.

You can adjust the height of a track by placing your mouse 
in the track header and in between the different tracks. 
When your mouse cursor changes shape to a double-head-
ed arrow with two lines through it, click and drag to adjust 
the height of the track. 

Figure 4.8  You can now save the 
Timeline track height view as a preset.

You can also adjust the size of 
the audio track by hovering your 
mouse pointer over the track 
button area and using the scroll 
wheel on your mouse to increase 
or decrease the size of the track. 
Additionally, you can change 
the height of all tracks (video or 
audio) by adding the Shift key as 
a modifier.

Why You May Not Want to Normalize

I’ve used the Normalize Gain option successfully, 
but in general I find that short bursts of very loud 
audio affect the normalization level, resulting in 
audio that is too low. 
	 A better way to normalize audio levels is to 
use a compressor, such as the Adobe Premiere 	
Pro CC Multiband Compressor effect, which I 
discuss later in this chapter.
	 If, on the other hand, you want to normalize 
clip(s) that have loud unwanted sounds, you can al-
ways cut right before and right after the unwanted 
sound. The unwanted sound will not affect the 
normalization of the clip, and it will not affect the 
gain of the “normal” volume section of the clip.
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Audio Track Buttons

Adobe Premiere Pro CC includes by default some com-
mon audio track buttons, such as Mute, Solo, Toggle Sync, 
Keyframe, and more (Figure 4.9). These buttons are used 
in the editing process to help you better perform your edit. 
If you need to keyframe the volume level of a particular 
clip, it might be better to listen to just that track; so soloing 
that clip makes sense. By the same token, if you need to see 
track keyframes instead of clip keyframes, you would select 
the appropriate setting using these buttons: 

.. The Mute button mutes the corresponding audio track 
and is useful when you want to isolate audio between 
tracks during playback. This button is used when you 
need to stop listening to a particular audio track mo-
mentarily so that it will not distract you.

.. The Solo button mutes all other tracks during playback. 
You can solo multiple audio tracks, which effectively 
mutes all tracks with the exception of those soloed. This 
is particularly useful when you have many audio tracks 
but at the moment you only need to listen to a few.

.. The Show Keyframes button toggles the display of key-
frames in the audio waveform on the track. If you have 
used track keyframes in your work, you will need to see 
them at some point. This button enables you to change 
the display of the Timeline to show you the track key-
frames instead of the clip keyframes. To display the clip 
keyframes again, just select the option from the same 
button (Figure 4.10).

.. The Previous Keyframe and Next Keyframe buttons 
navigate between existing keyframes on the audio track. 
These buttons are particularly important when you 
need to navigate between keyframes to adjust their set-
tings. It is easy to miss the time position of the keyframe 
if you drag the playhead, making any adjustments you 
make create a new keyframe. Therefore, it is better to 
use these buttons to navigate when you need to adjust 
an existing keyframe.

Figure 4.9  The audio track header view in the 
Timeline.

Figure 4.10  You can show either clip or track 
keyframes in the Timeline.

The disclosure triangle below the 
Show Keyframes button means 
that additional settings are avail-
able. Clicking the Show Keyframes 
button disclosure triangle allows 
you to select between track 
keyframes and clip keyframes. I 
discuss both in the next section.



247

Timeline Interface

.. The Add/Remove Keyframe button adds or removes 
keyframes (depending on the position of your play-
head). If the playhead is on a keyframe, clicking here 
will delete it. If the playhead is not directly on a key-
frame, clicking here will add a new keyframe at that 
point in the Timeline.

.. The audio Toggle Sync Lock determines which tracks 
will be affected when you perform an insert, ripple, or 
trim edit. Imagine you have several clips in several dif-
ferent tracks in your Timeline and you need to perform 
a ripple edit. Only the clips in the track that contain the 
edited clip will be affected. However, if the Sync Lock 
button is enabled in all of the tracks, any edit you per-
form in any of the tracks will make the clips in the other 
tracks adjust their time position to allow for the edit.

.. The audio Track Lock button goes a step further and 
locks the audio track completely, which prevents any 
change, accidental or intended. In essence, the Track 
Lock button “saves you from you.” Using this button will 
prevent you from accidentally making changes to a track.

Additional Audio Track Buttons

In addition to the default audio track controls mentioned 
in the previous section, Adobe Premiere Pro CC offers 
several additional buttons that you can add to the audio 
tracks. To add (or delete) any of these buttons, right-click 
on the track button area and choose Customize, or click 
the Timeline Display Settings button  and choose Cus-
tomize Audio Header. You can then drag and drop addi-
tional buttons to the track button area, or you can reset the 
layout by clicking the Reset Layout button in the Button 
Editor panel (Figure 4.11). 

These buttons are the Track Meter, Left/Right Balance, 
Track Volume, and Enable Track for Recording. To me, 
the ability to control some settings directly in the Timeline 
is both exciting and time-saving. 

Figure 4.11  The Button Editor lets you drag and 
drop additional buttons to the track header area.
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The most important track buttons that you might want to 
add are

.. The Track Meter button adds audio meters to the 
corresponding audio track. This is useful when you’re 
working with multiple audio tracks and you want to see 
the audio levels from individual audio tracks without 
switching to the Audio Clip Mixer panel. 

.. The Left/Right Balance button adds a left/right pan dial.

.. The Track Volume control allows you to increase the 
track volume level by +6dB or decrease it to  (infinity). 
The reason this is referred to as infinity is because dB 
(decibels) are a ratio. As stated earlier in this chapter, 
0dB is near silence; 10dB is 10 times as loud; 20dB is 100 
times as loud; 30dB is 1000 times as loud; and so on. You 
can click and drag left to decrease or drag right to in-
crease the volume level, or simply enter a numeric value.

.. The Enable Track for Recording button lets you record 
audio directly to the corresponding audio track.

Keyframes

Clicking the Show Keyframes button will let you choose 
between showing Clip Keyframes and Track Keyframes. 
Showing Clip Keyframes displays keyframes that are clip 
based, so if you move the clip, the keyframes follow the clip 
because they belong with the clip. These keyframes are the 
same keyframes that you would add in the Effect Controls 
panel. I discuss clip keyframes later in the chapter.

Track Keyframes

Track keyframes are added to the track and not the clip. 
Imagine you are editing your program and you need to 
add background music. You are not sure which track of 
music you want to add to your program. You add one clip 
to the track, and you add clip keyframes to the volume 
of that clip so that the music becomes softer when the 
voice-over starts. After listening to the edit several times, 
you decide that you no longer want to use that music clip, 
but instead you want to use a different clip. You delete the 
clip in the Timeline and add the new clip. However, the 

Tip: The numeric value for  
is -100.
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keyframes that you added to the original clip have disap-
peared when you deleted the clip.

Now imagine that instead of clip keyframes you added 
track keyframes to the original edit. Instead of the key-
frames disappearing when you delete the clip, they will stay 
with the track and apply to any clip you add to that track 
at that point in time. Now you can add as many different 
music clips to that track and the keyframes will apply.

Keyframes in action

To get a better understanding of how keyframes work, fol-
low these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Keyframes. 

You will see two different tracks, one showing clip key-
frames and the other showing track keyframes. 

	2.	 Move the clip with the clip keyframes, and then do the 
same with the clip in the other track. The clip with the 
keyframes maintains them, but the other clip does not 
because the keyframes belong to the track. If you find 
that you cannot move the clip that is in the track with the 
keyframes, temporarily show clip keyframes, move the 
clip, and then switch back to the track keyframes view.

Working with Separate Audio Tracks

Imagine you recorded an interview with your video camera 
and have different microphones going to different audio 
sources. It would be difficult for you to edit these clips 
separately if they show up together in the Timeline as a 
stereo clip, so you may want to separate both of these chan-
nels. To separate these channels into distinct (but linked) 
clips, choose Preferences > Audio and change the Default 
Audio Tracks options to fit your needs (Figure 4.12). In the 
previous scenario, you need the clips to come in as mono 
clips when importing that footage so you can edit each of 
the channels separately from the other one. Each channel 
of recorded audio will appear in its own track. Although 
having each channel in its own track is not always neces-
sary, it is very useful when needed. 

Figure 4.12  Check your Audio Preference settings 
to ensure that each audio channel appears in the 
Timeline as a separate track. 

One Track per Person?

Consider a documentary: There may be a narrator, 
some interviews (both male and female), back-
ground music, and some sound effects and natural 
(nat) sound. A professional audio engineer using 
an audio editing tool like Adobe Audition might 
give each audio its own track so adjustments 
can be easily made because each type of audio is 
isolated. However, in Adobe Premiere Pro, using so 
many tracks will be difficult unless you have a very 
tall monitor. 
	 Instead, I recommend that you place similar 
type clips together in a track. For example, add 
the narrator to a track, female voices to another 
track, male voices to a yet a different track, music 
to a fourth track, and sound effects to yet another 
track. You will still have the opportunity to apply 
track-level effects but will keep the number of 
tracks used to a minimum.
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Track naming

It is always a best practice to name your tracks. As a result, 
it will be easier to distinguish your audio when you’re work-
ing in the Mixer or even in the Timeline. You can easily 
name your track by right-clicking in the track header and 
choosing Rename. You can also rename the track using the 
Audio Track Mixer.

Mixing Sound

You have adjusted the gain of your clips and they are start-
ing to sound OK. However, you’re not done; you need to 
do more to your clips. Maybe some parts of your clips are 
still a little too loud, or maybe some of the different sounds 
on the different tracks are competing with each other. You 
need to make sure that this is not an issue, so you need 
to start mixing sound. To help you with this task, use the 
Audio meters (VU Meters). 

VU Meters

A VU meter lets you see how loud (and soft) your audio 
is. You need to constantly monitor how loud your audio is 
not only to maintain uniformity, but also to make sure that 
your audio does not clip: If the audio is so loud that the 
media cannot reproduce it, you’ll end up with a clip lack-
ing in dynamics, or a “square” instead of a wavy waveform, 
and the result will be distorted audio, which of course is 
highly undesirable (Figure 4.13).

Figure 4.13  Waveforms with square 
or “flat” areas at the top usually mean 
clipping/distortion has occurred.

If the amplitude of a signal goes 
beyond a digital system’s limits, 
that part will be discarded or 
“clipped.” This is particularly detri-
mental in digital audio because a 
large amount of definition can be 
lost through audio clipping. 
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Clipping

To better understand how clipping negatively affects your 
audio, follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Clipping. The sequence 
contains two different clips.

	2.	 Listen to the first clip; it hasn’t been processed.

	3.	 Listen to the second clip; it’s been processed through gain. 

In the second clip you’ll notice that there are less dynamics 
and that the audio goes into the red in the VU meter. The 
sound is also harsher and distorted in this second clip.

Dynamic range

All audio material has a DR. DR is the difference between the 
loudest and the softest part of your audio, and is measured in 
decibels. Depending on which genre of audio you’re working 
with, you’ll need to have a wider or narrower DR, so keep this 
is mind. As mentioned earlier, Classical music, for example, 
will have a much wider DR than Pop or Rock. 

To see this DR, you need to use the VU Audio meters.

	1.	 Open Chapter04_Audio.prproj, and then open the se-
quence named Dynamic Range. The sequence contains 
two different clips.

	2.	 Listen to the first clip and then the second clip. As they 
play, look at the Audio meters. The first clip has a DR of 
-28dB to -6dB. The second clip (through compression, de-
scribed later in this chapter) has a DR of -16dB to -12dB. 

Adobe Premiere Pro’s VU meter (Figure 4.14 on the next 
page) defaults to a 60dB range, displaying dynamic peaks, 
and shows color gradients that correspond to the audio 
levels. A gradient that progresses from green to yellow to 
orange to red indicates low audio levels, normal audio 
levels, and peaking audio levels. 



252

Chapter 4	 Professional Audio

Figure 4.14  Audio VU meters provide a clear view of your audio peaks and your DR.

You can customize the audio track meter by right-clicking 
and choosing one of the available options. Some of the 
options will be grayed out, depending on the type of audio 
master that you are using. Some of them are available 
only to 5.1 surround masters, or adaptive tracks. I prefer 
showing static peaks and valleys, and not showing the color 
gradients. This lets me see with more detail what my levels 
are and what my DR is. I use this information to help me 
set my levels (Figure 4.15). These options are

.. Show Valleys. Displays an indicator on the audio track 
meter that corresponds to the lowest audio amplitude in 
the portion of the clip that you play back. This is effec-
tively the noise floor. You should know what the noise 
floor is because it will help you determine the DR.
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Figure 4.15  Right-click on the VU 
meter and customize its display by 
choosing from these options.

Figure 4.16  You could change which 
channels you are listening to by 
choosing one of these options.

.. Show Color Gradient. Indicates track meter levels in 
a gradual gradient rather than hard color changes, 
although in such a small meter the difference is very 
subtle. Showing the color gradient is a little softer on 
the eyes, and it is fine if you don’t need to be very 
precise with the levels. I usually leave these off. How-
ever, I’ve met several editors who prefer to see the color 
gradients here. 

.. Solo in Place. Allows you to solo one or more channels 
without changing their speaker assignment (available 
for Source Monitor and Timeline panels). You may 
want to use this option if you need to temporarily listen 
to just one or some of the channels. When you select 
this option, you’ll see solo buttons at the bottom of the 
VU meters, one per channel (Figure 4.16).

.. Monitor Mono Channels. Allows you to listen to one 
specific channel out of both of your stereo monitor-
ing speakers regardless of its assignment (available for 
adaptive clips and multichannel masters). You may 
want to use this option if you need to temporarily listen 
to just one of the channels. When you select this op-
tion, you will also see solo buttons at the bottom of the 
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VU meters, one per channel. However, you will be able 
to solo only one of the channels at a time.

.. Monitor Stereo Pairs (default option). Allows you to 
monitor some of the channels from the left and right 
speakers (available for multichannel masters).

.. 120–24 dB Ranges. Allows you to change the decibel 
range from six options that range from 24dB to 120dB. 
You may want to change this range depending on how 
precise you need to be with your audio levels. Obvi-
ously, if you select the 120dB range, you will be able 
to more accurately see your level values than if you 
selected the 20dB range.

.. Dynamic Peaks. Allows you to see the max peak of the 
audio change depending on the part of the clips you 
are listening to. Levels are constantly refreshed every 
three seconds.

.. Static Peaks. Displays the loudest peak until the indicator 
is reset (by clicking on the meter) or playback is restarted.

.. Reset Indicators. Resets your indicators. 

Level Adjustment in the Timeline

By default Adobe Premiere Pro is set up to show clip key-
frames, which, as discussed earlier, also means that audio 
adjustments you make on the Timeline affect individual 
clips (not the entire track). 

You can adjust the volume level of an individual clip 
by hovering your pointer over the volume band until it 
changes to a volume band pointer (Figure 4.17). Then 
drag the volume band up to increase the volume by up to 
6dB or down to lower the volume to - . This adjustment 
affects the volume for the entire clip that is selected (if it 
doesn’t have any existing keyframes). But often you’ll want 
to make changes to the volume of a clip over time; you can 
do this by adding keyframes. This can be useful to fade in 
and out audio clips or to adjust for loud or soft sections in 
an individual clip. 

Audio VU Meter Target

Setting and monitoring audio levels in your 
program requires more than just making sure the 
audio is not too loud so it doesn’t distort Audio 
target levels differ depending on how you will 
deliver the final product. The Loudness Radar 
effect (discussed later in this chapter) will help you 
tremendously to achieve target levels. Here are 
two common targets:

.. Broadcast. Traditionally, many broadcast-
ers have maintained strict audio level 
requirements of -10dBFS for peak audio with 
average audio levels at -20dBFS. But some 
broadcasters are allowing editors to “work 
hot” and submit video with audio that has 
non-broadcast peaks of -3 or -6dBFS. Always 
check with your broadcaster because its 
requirements will vary.

.. Non-broadcast. Similar to how online video 
delivery doesn’t have a hard 100 IRE limit, 
online audio delivery doesn’t have a set peak 
limit. Therefore, I recommend limiting audio 
peaks to somewhere around -6dBFS and have 
average audio levels around -12dBFS.
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You can add clip keyframes either in the Timeline or by 
using the Effect Controls panel. If you’re working in the 
Timeline, you can add, select, move, and remove keyframes 
using the Pen tool.

	1.	 Select the Pen tool (press P) from the toolbar 
(Figure 4.18).

	2.	 Play the Timeline and determine the points in time at 
which you need the audio to become softer or louder. 
Then click on the band to add the keyframe. 

	3.	 Using the Selection tool, drag individual keyframes or 
sections between keyframes up or down to increase the 
clip volume at that point in time.

	4.	 Play back the audio clip, and look at the peaks and val-
leys of the audio in the VU meter.

	5.	 In some cases you’ll need the same keyframes in more 
than one place or in more than one clip. You could have 
more than one track or music or dialogue that requires 
the same changes in volume. You could copy these key-
frames and then paste them as needed, either to the same 
clip in a different point in time or to a different clip. 

Figure 4.17  You can change the vol-
ume levels of your clips by dragging 
the volume band up or down. 

Figure 4.18  You can balance the 
audio levels over time by adding 
keyframes in the Timeline.
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Other ways of adding keyframes

Here are a few other ways you can use to add keyframes to 
the Timeline:

.. Use the Selection tool instead of the Pen tool by hold-
ing down the Command (Ctrl) key and clicking on the 
points at which you want to add a keyframe along the 
clip’s volume band (also known as the rubber band). 

.. Use the Add/Remove Keyframe button.

.. Adjust the audio volume of a nonselected clip by using 
the [ and ] keys . If the playhead is on a keyframe, you 
will adjust that keyframe only. If the playhead is not on 
a keyframe, you will adjust the span between keyframes

.. Quickly reset keyframes by clicking on clip(s) and 
choosing Clip > Remove Effects.

Keyframes in action

To get a practical understanding of how to use keyframes, 
follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Begin Keyframes. 

	2.	 Play the sequence. You will hear that the music fades as 
the voice starts. 

	3.	 If necessary, expand the track; then notice that some 
keyframes were added.

	4.	 Play the sequence again and listen to the audio levels as 
the playhead goes through the sections with keyframes.

	5.	 Add other keyframes to make the audio get louder and 
softer over time. 

Track Keyframes

Track keyframes are identical to clip keyframes except they 
are applied to the track, not to the clip. So, if you were to 
move, remove, or change a clip in the Timeline, these key-
frames would remain unaffected and would apply to any 
clip placed in the track where the keyframes are located. 
I’ll discuss track keyframes further in the “Track Mixer” 
section later in this chapter. 
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Crossfades

Crossfades are the gradual lessening of the audio volume 
in one clip at the same time as the gradual increase of 
the volume of a different audio clip. They are used in two 
different ways: to fade in between two clips and to fade up 
from silence. It is common to fade a clip up from silence at 
the beginning and fade down to silence at the end because 
not doing so may cause the sound of those clips to “pop” in 
and out (there might be loud ambient sound or a loud first 
sound in the clip). This means that you would need to fade 
in and out every audio clip in your entire program.

To avoid manually keyframing these clips, you usually use 
crossfades. An audio crossfade is a transition, a lot like a 
video crossfade, that is used instead of manually keyfram-
ing the clips to fade them up from or down to silence.

Open the project Chapter04_Audio.prproj, and then open 
the sequence named Crossfades. Play the sequence. You’ll 
notice that there are crossfades added to the first clip in 
the Timeline and that it fades in at the beginning and out 
at the end. 

If both clips are adjacent in the same track, you can easily 
add a crossfade by adding a transition: Adobe Premiere 
Pro creates the overlap from handle media, and a single 
transition will suffice for the edit point. You can see an 
example of a crossfade on the next set of clips in the Cross-
fade sequence. Notice how the crossfades affect the audio. 
If the clips are in two different tracks, you can still use the 
audio transition, but you need to ensure that the clips 
overlap by the amount of time that you want the crossfade 
to last. Of course, you can also use keyframes to accom-
plish the crossfade. You can see an example of crossfades 
that exist between clips in different tracks in the next set of 
clips in the Crossfade sequence.

For multiple clips

To add crossfades to multiple clips at the same time, adjust 
the default transition duration for the audio crossfade first 
and then use the transition. You can change this value by 
choosing Preferences > General and changing the Audio 
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Transition Default Duration (Figure 4.19). Because I pre-
fer a fast crossfade, I usually set this value to between 0.10 
and 0.17 seconds, which in NTSC will give me a duration 
of three to five frames. 

Then select the clips you want to affect and choose 
Sequence > Apply Audio Transition (Figure 4.20).

When you’re doing crossfades, avoid these two mistakes:

.. If you made your cuts a little too close, the audio might 
fade out too soon.

.. If you do a crossfade in between two clips, you may be 
adding unwanted sounds, because Adobe Premiere 
Pro will add enough frames to the edit to create the 
crossfade.

Exponential Fade, Constant Power, Constant Gain

As you may already know, there is more than one type of 
crossfade. The difference is in the rate of change of the 
levels during the transition. You should use Exponential 
Fade when coming up from silence and Constant Power 
when using a crossfade in between two different clips. The 
different types of crossfades are

.. Constant Gain. Changes the audio at a constant rate. 
This is not very natural, which is why it is not used 
much (Figure 4.21).

.. Constant Power. Creates a slow fade that gradually 
changes to a faster rate of change when fading out. 
When fading in, the opposite occurs: Constant Power 
increases the rate of the audio and then as the fade pro-
gresses the rate of change slows down. This causes the 
levels to not “lose power” during the transition, which 
is what would have happened if you had used Exponen-
tial Fade (Figure 4.22).

.. Exponential Fade. Uses a logarithmic curve to fade 
up and down. It is very similar to the Constant Power 
fade but is more gradual. This is more natural to your 
ears because this is how you naturally perceive sound 
(Figure 4.23).

Figure 4.19  You can adjust the default duration 
of the audio transition by accessing the General 
preferences and changing the time duration.

Figure 4.20  You can apply audio transitions to 
your selected clips by choosing Sequence > Apply 
Audio Transition.
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Figure 4.21  Constant Gain changes 
the audio at a constant rate. 

Figure 4.22  Constant Power changes 
gradually and then speeds up the rate 
of change.

Figure 4.23  Exponential Fade uses 
a logarithmic curve to fade up and 
down. The fade is slower at the begin-
ning but gets faster in the middle of 
the duration of the transition.

Noise Floor/Room Tone

All rooms have a “sound,” or “room tone,” that is generat-
ed by lights, furniture, and even the people in it. No place 
is totally silent (unless you’re in a vacuum). You should 
record at least 20 seconds (at the very minimum) of this 
room tone (make sure you record it during production). 
Mixing it with your clips on a separate track will help you 
create the illusion of evenness.

Panning

Panning places the signal anywhere between hard left and 
hard right in a stereo recording (or in any of the channels 
of a 5.1 surround panning). It is used to give the percep-
tion of depth and space (Figure 4.24). In other words, 
panning will give listeners a better illusion that they were 
present during the events presented in your program. 

For example, if you see a car moving from left to right, the 
sound should move from left to right following the car. 
Panning accomplishes that through animating (keyfram-
ing) the panning so that the sound goes from one channel 
to the other gradually, just like the sound of the car would 
travel from one side to the other in real life.

You can adjust panning on a global basis, or you can 
animate it (as just explained in the preceding moving car 
example). Most of the time I’ll set panning to about 30 
percent into a channel (rarely any more than that). I won’t 

No room tone? Find the longest 
amount of silence in a spoken track 
for a minimum of one second. Place 
this little audio piece into its own 
sequence and then reverse it. You 
now have at least two seconds of 
room tone and don’t have to play 
games with crossfades to make it 
work. Build 30–40 seconds and you 
can add it to your clips as needed. 

Figure 4.24  Adjusting the pan of a stereo clip 
adjusts both channels. However, adjusting a mono 
clip’s pan adjusts independently by clip or track.
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go all the way to 100 percent unless the sound is coming 
from offscreen. 

In my experience, the following is usually true:

.. True stereo recordings (most commercially available 
music) will not need any panning modification.

.. Voice-overs will almost always be right in the center.

.. Interviews can pan (a little) to the left and right to cor-
respond with the speaker’s positioning on the screen.

.. SFX will also correspond to whatever on the screen is 
producing the sound. 

Mixers and Submixes

Mixing audio on the Timeline alone can be restrictive, 
especially when you’re trying to mix down several differ-
ent clips and audio on multiple tracks. For more advanced 
audio mixing controls, Adobe Premiere Pro CC offers two 
different audio mixers that you can use to speed up and 
increase your control over the audio mixing levels. 

These mixers are the Audio Clip Mixer and the Audio 
Track Mixer. You use the Audio Clip Mixer when you need 
to change the levels of individual clips on a clip-by-clip 
basis. You use the Audio Track Mixer when you need to 
change the levels of audio on a track basis, when you don’t 
need the changes to travel with the clips in case you need 
to replace the clips with different ones. Track and clip key-
frames were discussed earlier in this chapter.

Clip Mixer

The Audio Clip Mixer is a new feature in Adobe Premiere 
Pro CC that allows you to view and adjust audio on a clip-
by-clip basis. You can access this new window by choosing 
Window > Audio Clip Mixer or by pressing Shift+9. 

Using the Audio Clip Mixer (Figure 4.25) lets you moni-
tor and adjust individual clips on the go, even if they are 
in the Timeline. If you play your program in the Timeline 
and use the Audio Clip Mixer to adjust levels during the 
playback, the Clip Mixer will affect the clips as you hear the 
audio being played from the Timeline. You’ll be able to 

Figure 4.25  Using the Audio Clip Mixer allows you 
to add clip keyframes in real time as you listen to 
the clip being played in the Timeline.
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perform changes on the fly. Any changes you make to the 
volume of the clip using this tool will be reflected in the 
Timeline volume line (rubber band). When you’re using 
the Clip Mixer, note that only the clip is affected, not the 
track (the Track Mixer affects the track level).

As you move the playhead along, tracks that contain audio 
clips will become available to control; the controls for those 
tracks that don’t contain audio clips will be grayed out.

To better understand how the Audio Clip Mixer works, fol-
low these steps.

	1.	 Move the playhead to the spot in the Timeline where 
you want to start your changes.

	2.	 In the Audio Clip Mixer panel select the keyframe icon 
for the tracks that you want to affect. Remember that 
although this selection is on a track-by-track basis, the 
adjustments made are applied to clips, not tracks.

	3.	 Mute any tracks you don’t want to hear or solo a single 
track if you need to.

	4.	 Start playback, move the volume level up and down, 
and pan left and right as desired.

When you stop playback, keyframes will be added.

	5.	 Adjust the keyframes if needed, or even record a 
second pass.

	6.	 Play back and enjoy your work!

Audio Clip Mixer practice

To better understand how the Audio Clip Mixer works, 
follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Clip Keyframes. 

	2.	 Open the Audio Clip Mixer panel and click the Write 
Keyframes icon.

	3.	 Play the Timeline, and as it plays, adjust the Volume fader. 

Notice that when you’re done, keyframes are on your 
clip (if you do not see them, make sure Clip Keyframes 
is selected in the audio track header). 

When you stop recording 
keyframes in the Audio Clip Mixer 
panel, Adobe Premiere Pro creates 
a final keyframe at the point in 
time where you stopped. This key-
frame is often an abrupt change 
from the next-to-last keyframe, so 
I recommend deleting it. Simply 
select that keyframe and then 
press the Delete key.
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Track Mixer

The Audio Track Mixer has Volume and Pan controls, and 
it will add keyframes, but instead of making changes to 
a clip it makes changes to the audio tracks. I usually use 
these track keyframes in conjunction with clip keyframes. If 
I’m editing a segment with a voice-over preceded by music, 
I’ll add track keyframes to fade the music at the appro-
priate time, and if needed, add clip keyframes to further 
adjust the level of the music.

To open this tool, choose Window > Audio Track Mixer 
(Figure 4.26).

Several automation modes help you create the keyframes 
that will affect your track (Figure 4.27):

.. Off. This setting, as you may have guessed, ignores 
existing keyframes. Even though you can still make 
changes to the track, these changes will not be record-
ed. Off is simply, off.

.. Read. After you’ve created some keyframes, change 
the automation mode to Read to hear how they sound. 
Read mode will read any changes that you’ve already 
performed on the clip. If a clip has no keyframes and 
you adjust a track, the changes will affect the entire 
track. Once you stop adjusting, the fader will return to 
its former value. The speed of the return is determined 
by the Automatch Time option (Preferences > Audio > 
Automatch Time).

.. Write. This automation mode lets you record any 
changes to volume or pan that you make to the track 
(as long as the Automation Mode is not set to Safe Dur-
ing Write). When you adjust the levels using this auto-
mation mode, new keyframes will be added, overwriting 
existing ones. You could also preserve a track property 
while recording the mix by right-clicking an effect or 
send and choosing Safe During Write from the menu.

.. Latch. Similar to Write, but Latch changes don’t start 
recording until you begin adjusting the property. So, if 
you are set to Latch and you play the track, nothing will 
be altered until you actively start adjusting.

Figure 4.26  The Audio Track Mixer makes changes 
to the audio tracks through keyframes or through 
changes to the whole track’s level.

Figure 4.27  The automation modes in the Audio 
Track Mixer panel create keyframes on the go as 
you listen to the audio in the Timeline.
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.. Touch. Same as Write, but when you stop adjusting 
a property, the fader will continue following existing 
keyframes, or return to the original value of the clip 
if there are no keyframes present. The speed of the 
return is determined by the Automatch Time option 
(Preferences > Audio > Automatch Time).

To better understand how the Audio Track Mixer works, 
follow these steps.

	1.	 Move the playhead to the spot in the Timeline where 
you want to start your changes.

	2.	 In the Audio Track Mixer panel select the desired auto-
mation mode. 

	3.	 Mute any tracks you don’t want to hear or solo a single 
track if needed.

	4.	 Start playback, move the volume level fader up and 
down, and pan left and right as desired.

	5.	 When you stop playback, keyframes will be added. If 
you do not see these keyframes, click the Show Key-
frames button in the track header and choose Track 
Keyframes. 

	6.	 Adjust the keyframes if needed, or even record a sec-
ond pass.

	7.	 Play back and enjoy your work!

If you feel you are adding too many keyframes, check and 
adjust the value in Preferences > Audio > Minimum Time 
Interval Thinning; larger values will reduce the number of 
keyframes. If you create keyframes that make changes that 
last one second, this option will create only the necessary 
keyframes at the beginning and at the end of the change. 
Otherwise, Adobe Premiere Pro may create other key-
frames in the middle of these.

To make this process easier, rename your audio tracks from 
the default of Audio 1, Audio 2, and so on to reflect the 
type of clips you’ll be placing on the track, such as male 
voice, female voice, nat sound, music, effects, and the 
like. You can rename your audio tracks in the Audio Track 
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Mixer or in the Timeline. To see an example of renam-
ing tracks, open the project Chapter04_Audio.prproj, and 
then open the sequence named Mix. Notice the names of 
the tracks in the Audio Track Mixer.

Audio Track Mixer practice

To better understand how the Audio Track Mixer works, 
follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Track Keyframes.

	2.	 Open the Audio Track Mixer panel and select the Write 
automation mode. 

	3.	 Play the Timeline, and as it plays, adjust the Volume 
fader or the Pan control.

Notice that when you’re done, keyframes are added to 
your track (if you don’t see them, make sure you have 
Track Keyframes selected in the audio track header).

	4.	 Test the different automation modes and experience their 
differences. Remember to adjust the Automatch Time 
value in the Audio Preferences if you need to do so.

Submixes

In audio a submix is a grouping of tracks that are pro-
cessed together to add some common effects. In Adobe 
Premiere Pro you use a submix mainly to avoid having to 
add the same effects over and over to many clips, and to be 
able to adjust levels of several tracks at the same time. 

A submix is akin to a nested sequence, where you can add 
effects to the nested sequence instead of adding many dif-
ferent effects to many different clips (Figure 4.28). Con-
sider a submix an intermediary track between the original 
tracks and the master track. The source for this interme-
diary track is other audio tracks, so you cannot add clips 
directly to this submix track; however, you can add as many 
tracks to a submix as you need. 

A send takes the audio signal from a track and “sends” it 
somewhere else before it goes to the master track. This is 
what you use to route audio tracks through submixes. 

Figure 4.28  Submixes let you adjust several tracks 
at the same time.
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To create a submix, you can use the Send Assignment 
menu on the Track Mixer, or you can right-click on the 
audio track button area in the Timeline and choose Add 
a Submix Audio Track. Then, in the Audio Track Mixer 
panel, select the Sends drop-down from the track(s) you 
want to send to the Submix track and choose Submix.

In the Audio Track Mixer panel you can adjust the fader 
and/or add any effects you desire to the submix.

Submixes practice

To better understand how submixes work, follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Submix. 

	2.	 Open the Audio Track Mixer panel, which contains two 
submixes: one called SFX submix the other called VO 
Submix. The different tracks are being routed to dif-
ferent submixes except for the music track, which goes 
directly to the master. Some effects are already applied. 

	3.	 Test different settings and experiment with different 
effects to hear how they affect your sound.

Audio FX

Even after you’ve mixed your audio, it still might not 
sound right. Some clips may have unwanted noise or still 
be too loud or too soft. Effects are the solution to these 
problems, although some clips cannot be completely fixed. 
This section discusses some of the most commonly used 
audio effects.

Pre-fader or Post-fader?

Sends can be applied pre-fader or post-fader 
(Figure 4.29). If you choose pre-fader, the send 
ignores the fader control track, which means that 
it will ignore any level changes applied to the 
track. If you choose post-fader, the send level is 
based on the fader control (and still has its own 
level of adjustment too). So, if your fader is set to 
–4dB, a post-fader send will begin at –4dB, but 
a pre-fader send will be at 0dB regardless of the 
fader level. 
	 Most of the time you will want a post-fader 
send, because it seems natural that if you adjust 
the track’s volume, the signal that is sent to the 
submix would be adjusted in turn. However, 
sometimes you want the signal that is being sent 
to the submix to remain unchanged no matter 
what happens to the fader of the track. A good 
example of using a pre-fader send is to keep a 
reverb effect consistent regardless of the track 
fader level. To change the post-fader default of the 
send, right-click on the send’s name in the Track 
Send Assignment menu (in the Audio Track Mixer) 
and choose Pre-Fader.

Figure 4.29  Pre-faders and post-faders 
will ignore or follow the fader in the Audio 
Track Mixer before going to the submix.

Using Your Master Track

Although it is generally not recommended, you could use your master track in lieu of 
a submix. All of your tracks will be added to the master track anyway, so why not use 
it to your advantage?
	 You could use your master track to add effects and even to adjust volume. In a 
pinch, you could also use it to do a quick but effective last-minute adjustment to 
your program.
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Multiband Compressor

A compressor is the tool that can help raise or attenuate 
the relative level of the clip and gives your audio punch 
and strength (Figure 4.30). You may want to use a com-
pressor when you need your audio levels not to go any 
louder than a certain value or to remain between a certain 
range of values. When editing for broadcast (usually com-
mercials), I usually run all of my audio through a compres-
sor/limiter on the master track, which helps me remain 
within the broadcast audio levels. 

You should think about audio levels in two different ways: 
One is the absolute level—the level that the meter dis-
plays—and the other one is the subjective level, which is 
how loud you perceive the volume. 

Figure 4.30  A compressor is one of 
the most commonly used tools; it lets 
you control the DR of voices and/or 
instruments.

The Multiband Compressor is 
powered by iZotope and is the same 
compressor found in Adobe Audition. 
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Can you recall a certain bathroom tissue commercial 
where people were whispering? This gave the perceived 
level of being quiet. In reality the audio levels were just as 
loud as when the announcer was plugging that particular 
brand. What the meter displays and what you perceive are 
sometimes different. 

Adobe Premiere Pro’s Multiband Compressor effect 
separates the audio into different frequencies (or bands) 
and processes them separately; what this means is that 
you could affect some frequencies in one way and other 
frequencies in a different way. Based on frequencies, you 
could affect some instruments and not others. This could 
be useful if you are editing a music video and need to mas-
ter the audio as well, for example, maybe the bass is too 
soft or too loud. Using this effect you could affect only the 
frequency in which the bass sound exists. 

Here are some controls in the Multiband Compressor that 
you should know:

.. Threshold. Threshold is the minimum level that will 
make the compressor start working. Depending on the 
ratio (described next), the compressor will “kick in” 
when your audio levels reach the threshold you set on 
this effect. The threshold is commonly set in decibels; 
a lower threshold (e.g., -60dB) means more of the clip 
will be compressed.

.. Ratio. The amount of gain reduction is determined by 
the ratio: A ratio of 3:1 means that if the input level is 
3dB over the threshold, the output signal level will be 
1dB over the threshold. In this case, the gain (level) is 
reduced by 2dB. For example:

.. Threshold = −10dB

.. Input = −7dB (3dB above the threshold)

.. Output = −9dB (1dB above the threshold)

Try to keep the ratio at no more than 3:1 to maintain a 
gentle-sounding effect. If the ratio goes above 3:1, the 
audio might sound unnatural.

Do not overcompress your audio. 
Hypercompressed programs do 
not sound natural. Too much com-
pression robs the mix of vivacity. 
In fact, they are tiresome and dull. 
Also, keep in mind that MP3s have 
difficulties encoding hypercom-
pressed material. You can tell when 
audio has been over compressed 
not just by the sound but by how 
the waveforms look when you 
see them in the Timeline. Hardly 
any waves are displayed; they are 
all flat!

Using a Limiter

Within the Fx Editor of the Multiband Compressor 
effect is a Limiter section. Imagine, if you will, that 
most of your audio levels are fairly even and that 
you have short (in duration) waves that get pretty 
loud. This is the perfect scenario in which to use a 
limiter. The limiter affects only those short duration 
bursts without affecting the overall level of audio. 
If you control these peaks, you can raise the entire 
level of the program without fear of distortion.
	 A brick wall limiter ensures that the levels will 
not exceed a certain indicated level.
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.. Attack. Attack is the time that it takes to reach maxi-
mum level of compression. Attack will affect drums if 
the release is too fast, which will result in unnatural 
level changes.

.. Release. Release is the time that it takes for the audio 
level to return to normal (no compression). You should 
have slow release times to minimize the unnatural level 
changes (pumping).

If your clip has a wide DR, you’ll notice the compression 
more because it will click more often and for a less amount 
of time. 

EQ

An equalizer (EQ) is an effect that will let you balance dif-
ferent frequencies throughout your program (Figure 4.31). 
You will be able to select a specific frequency (or range of 
frequencies) and adjust their levels to increase or decrease 
their volume. 

For example, if you are working with a music clip in which 
you can hardly hear bass, you could add the EQ effect and 
increase the volume of the bass only, making it more pres-
ent in the mix. 

To better accomplish this task, you can train your ears to 
recognize a well-balanced audio program by playing good 
audio through your system. Play audio that is similar to the 
program that you are mixing. If you are mixing a high-
impact commercial, listen to something comparable. It’s 
best if the sample audio is the same genre as the program 
you’re working on. 

As you become more familiar with the EQ tool and your ears 
begin to detect audio nuances, your changes will be very small. 
You will have changes in many places, but these changes will be 
minimal—for example, 2dB or 3dB at the very most.

When you want to use the EQ effect because you need to 
do more than make small adjustments, reconsider your mi-
crophone placement and your audio recording techniques. 

Figure 4.31  An EQ helps balance the frequencies 
throughout your program.
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When you’re working with the EQ, do not alter the volume 
of your speakers (seriously, don’t touch this volume at all). 
If you do, you might overcompensate and the EQ will not 
be accurate.

Constantly compare the processed audio with the original 
version. Also, compare your clips with each other. Using 
the EQ is one of the ways to achieve audio continuity in 
your program.

To use the EQ effect, follow these steps.

	1.	 Add the EQ effect to the clip (or the track).

	2.	 Launch the clip Fx Editor by clicking the Edit button in 
the Effect Controls panel. To launch the Track Mixer, 
double-click the Fx slot where the EQ is located.

A Little About the Sound Spectrum and EQs

An equalizer allows you to lower or raise any individual frequency in the sound 
spectrum and it’s helpful to have a general understanding of the “map” of 
frequencies.
	 Human hearing ranges from about 20 Hertz (Hz) (very low tones) to approxi-
mately 20,000 Hz (very high whistles).
	 Low bass sounds (think hums and rumbles) register at about 50–60 Hz. Men’s 
voices register in the 600–800 Hz range, whereas women and children’s voices tend 
to be a little higher (800–1200 Hz for women and 1000–1400 Hz for children). 
Voices may be higher or lower (harmonics, certain parts of speech) but these ranges 
are generally where the strength of the voice exists.  
	 Above 3,000 Hz (or 3 KHz), you’ll find higher pitched sounds. Above that, we 
begin to get into the ranges of whistles. The sibilant “S” sound that some people make 
registers at around 5 KHz. A DeEsser is a specialized EQ that lowers sound in that range.
	 Classically, an EQ designed for speed lowers the section below 100 Hz (taking 
out rumbles in a room), boosts the area around 700 Hz just a couple of DB (for a 
male’s speech to come through clearly), and lowers the spectrum higher that 3 KHz 
(removing high whines).
	 A great technique is to reverse this for non-speech sections (such as music) 
during moments where both music and speech occur. Since the speech EQ increases 
the speech ranges and the music EQ lowers those same exact ranges, they tend not 
to be perceived as competing as much during playback.

Feathering is a commonly used 
technique where instead of increas-
ing one frequency you increase a 
number of adjacent frequencies to 
produce a smoother curve.
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	3.	 Choose from several presets that are available. Once 
you become familiar with this tool, you can even create 
your own. Sometimes it’s easier to start from a preset 
and then adjust it rather than starting from scratch.

	4.	 Select the appropriate check boxes in the Fx Editor. 
To make adjustments, you can either use the knobs or 
simply click and drag the control points. Notice that 
the control points are “connected,” which means that 
the resulting feathering effect will sound more natural.

	5.	 Adjust the Q control, which controls the smoothness of 
the curves that “connect” the control points. You can 
either adjust these control points by using the knob or 
by clicking and dragging the handles directly on the 
control points.

	6.	 Adjust the overall gain by using the Output Gain slider 
to the right of the knobs. 

EQ practice

To better understand how the EQ works, follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named EQ. The sequence contains 
two different groups of clips in the Timeline in two dif-
ferent tracks. The first one is unprocessed; the second 
clip has the EQ effect added to the track

	2.	 Listen to both clips.

	3.	 Open the Audio Track Mixer.

	4.	 Open the Fx Editor for the EQ applied to the second 
track (by double-clicking on it).

	5.	 Note how the frequencies were modified (Warm Pres-
ence preset), and try making some changes of your own 

Start training your ears to distinguish between the 
sound qualities of the different changes.

Double-check your levels. An EQ 
effect can increase the volume 
of specific frequencies, and it is 
common that in the process of 
EQing your audio clip or track you 
increase (or decrease) the overall 
level. This can easily be adjusted 
using the Output Gain slider in the 
Fx Editor.
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Loudness Radar

The Loudness Radar effect (Figure 4.32) is a tool that lets 
you read the loudness of your program over time. If the 
audio will be used in a program destined for broadcast, 
you are probably aware that you’ll need to comply with 
loudness standards. If you don’t, the broadcast house may 
adjust your audio levels or it might simply reject your pro-
gram. You could also use this effect to compare the levels 
of the different clips of your program; that is, how much 
louder than the music is the voice-over track?

The Loudness Radar displays audio levels in two rings: 
The outer ring shows current audio levels, and the inner 
ring shows the audio levels over time (a useful history of 
loudness). At the bottom of the Loudness Radar screen 
you can also see loudness range values and the overall 
program loudness. 

The yellow area is the loudest level (don’t exceed this level). 
The blue level is too low (below the noise floor), so you want 
your audio to stay between the green and the yellow levels.

You can change the loudness standards, and see where 
your program falls within the different standards. These 
Loudness Standard presets are in the settings of the effect, 
and you can choose between BS.1770-3 and Leq(K). These 
standards are presets that change the values in the Settings 
tab. Here are some of those settings:

.. Radar Speed. You can change this value to an appro-
priate time (the length of the program) to display the 
history of the program’s loudness.

.. Radar Resolution. This is the space increment of the 
inner circles.

.. Momentary Range. This sets the loudness for the mo-
mentary range. It offers two different choices: EBU +9 
is meant for normal broadcast, and EBU +18 is meant 
for film, drama, and a wide range of music.

.. Low Level Below. With this setting you can set the shift 
between the green and blue colors on the momentary 
loudness ring. This could be set to indicate that the 
level may be below the noise floor level.

Figure 4.32  The Loudness Radar effect is new in 
Adobe Premiere Pro CC. It lets you ensure that your 
program is compliant with broadcast standards. 
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.. Overall Audio Units. This sets the loudness units to be 
displayed on the radar. Choose between units for the 
International Telecommunications Union (ITU) and 
the European Broadcast Union (EBU).

.. Loudness Standard. This sets the loudness standard. 
Choose between BS.1770-3 and the Leq(K) loudness 
standard.

.. Peak Indicator. This sets the value at which the peak 
indicator will be activated. The red peak indicator lights 
up if you exceed the indicated level.

The Loudness Radar applied to just one clip isn’t that useful 
when you have multiple audio clips and multiple audio tracks.

This effect is best used in the master audio track. You can 
either nest your Timeline into a new sequence or add the 
effect directly to the master track in the Audio Track Mixer.

Loudness Radar practice

To better understand the Loudness Radar effect, follow 
these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Loudness Radar.

	2.	 In the Audio Track Mixer, open the Fx Editor for the 
Loudness Radar applied to the master track.

	3.	 Mark In and Out points, and then click the “Loop play-
back” icon. This will place your playback in a repeat mode 
that will only stop when you manually pause the playback. 

	4.	 Start playing your Timeline.

	5.	 As it plays, note how the effect works by changing the 
levels of the track (not the master), and notice how the 
radar display changes. 

	6.	 Increase levels so you can see the peak warning.

DeHummer

A DeHummer is an effect that will help you get rid of an 
unwanted frequency that is usually caused by power lines 
from lights and electronics. I’m sure you have heard a 
loud hum that seems to come from everywhere and almost 

You can also apply the Loudness 
Radar effect to individual tracks in 
the Audio Track Mixer. This is useful 
when you want to monitor the levels 
of music on one track and dialogue 
on another to ensure that the music 
is quieter than the dialogue.
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totally ruins the good audio you want to retain. Hum in 
your audio is never good, and quite frankly, should have 
been caught during the recording process. However, 
sometimes you don’t have a say in which audio you get and 
who recorded it, so you might end up with audio with hum 
(Figure 4.33).

More often than not, audio hum comes from improp-
erly electrically grounded audio equipment or induction 
(audio lines next to power lines). The frequency of your 
ground hum will match your electrical power—60Hz in 
North America and 50Hz in Europe.

To use the DeHummer effect, follow these steps.

	1.	 Add the DeHummer effect to the affected clip in your 
Timeline.

	2.	 In the Effect Controls panel locate the DeHummer ef-
fect, and click Edit to launch the Clip Fx Editor for the 
DeHummer effect.

	3.	 Select one of the available presets, which is a good 
place to start.

	4.	 Adjust the following parameters until the hum is gone:

.. Frequency. Specifies the frequency you target.

.. Q. Specifies the width of the frequency band. A 
frequency band is a small section of the spectrum of 
frequencies.

.. Gain. Specifies the amount by which to decrease 
the band. 

.. Number of Harmonics. Adjust this value to de-
termine the number of harmonic frequencies to 
filter. In addition to the common 50Hz and 60Hz 
electrical hum, you can also experience hum at the 
multiples of the base frequency (100, 200, 400 or 
120, 240, 480Hz, etc.). 

For example, if you choose 60Hz as the Frequency 
value and choose 4# as the Filter value, the DeHummer 
filters the 60Hz frequency along with three harmonic 
frequencies (120Hz, 240Hz, and 480Hz). A total of four 
frequencies are filtered, hence the value of 4#. 

Figure 4.33  The DeHummer helps remove un-
wanted specific frequencies from the audio—more 
specifically 50Hz and 60Hz hum.

Avoid Hum While Recording

If you’re experiencing hum while recording, try 
these tactics:

.. Power your camera with a battery instead of 
an AC adapter.

.. Place your audio and video cables at least one 
foot apart, or (if you can) at right angles to 
each other.

.. Use balanced audio cables.

.. Shut off fluorescent lights that can sometimes 
cause hum.
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	5.	 Preview changes to your audio, select the Output Hum 
Only check box, and resume playback. If you hear too 
much of your good audio, adjust your settings. 

DeHummer practice

To better understand how the DeHummer works, follow 
these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Hum.

	2.	 In the Audio Track Mixer, open the Fx Editor for the 
DeHummer applied to the master track.

	3.	 Mark In and Out points, click the “Loop playback” 
icon, and start playing your Timeline.

	4.	 As it plays, alter the values of the effect (not the mas-
ter), and note the changes. To hear it work, choose the 
preset “Remove 60Hz and Harmonics.”

DeEsser

A DeEsser is an effect used to reduce the amount of 
sibilance (“sss”) in a clip. Some recordings can sound as 
though someone is scraping fingernails on a blackboard 
(Figure 4.34). This is the undesirable effect that a huge 
sibilance sound has on me. Sibilance is a short burst of 
high frequency sound where the ”esses” are emphasized. 
In some voices the ”esses” are very prominent. This is usu-
ally caused by a combination of voice quality, pattern of 
speech, and poor microphone placement. 

Most DeEssers have two main controls: Threshold and Fre-
quency, which are used to compress only a very narrow band 
of frequencies—anywhere between 3K and 10K to eliminate 
sibilance. Sibilance usually exists somewhere between 4Khz 
to 10Khz depending on the voice and the recording.

Apply the DeEsser to your clip and use one of the handy 
presets. If the preset is not quite right, you can adjust some of 
its settings. However, if you don’t want to use a preset, raise 
the Threshold control until the sibilance is gone but you can 
still hear the esses. Next, adjust the Frequency range until you 
find the exact setting that will fix the issue. Then go back to 
the Threshold again and adjust it until it sounds natural.

The frequency of hum isn’t exactly 
at 50Hz or 60Hz because electrical 
frequency can vary. Adjust the base 
frequency +/- 5Hz to see if that 
makes a difference. The more precise 
your base frequency and the smaller 
your Q value, the less damage you 
do to the good audio. Use only the 
necessary number of harmonics. 

To better pinpoint your base hum 
frequency, find a spot in your clip 
where there is no good audio and 
mark In and Out points. Loop this 
playback. Add the DeHummer 
effect and change the settings to a 
narrow notch (Q). Raise the gain as 
far as it goes and gradually change 
the frequency value. Once it gets 
awful, you have identified the base 
frequency to eliminate. Change the 
harmonics to a number that will 
work with your clip and then lower 
the gain, fixing the hum.

Figure 4.34  A DeEsser removes unwanted sibi-
lance from your audio.
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DeEsser practice

To better understand how the DeEsser works, follow 
these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named DeEsser.

	2.	 In the Audio Track Mixer, open the Fx Editor for the 
DeEsser applied to the master track.

	3.	 Mark In and Out points, and click the “Loop play-
back” icon.

	4.	 Start playing your Timeline, and as it plays, experiment 
with the values of the effect (not the master) and note 
the changes.

	5.	 Bypass the effect so you can get a clear idea of the be-
fore and after sound.

Reverb

A reverb effect is a room simulator; it imitates the charac-
teristics of a place and adds the necessary changes to the 
audio to give the audience the illusion that the sound is 
coming from a room of a particular size and acoustical 
properties (Figure 4.35).

Arguably, reverb is one of the most commonly used effects. 
Actually, it is one of the most commonly misused effects. 
Therefore, you should use reverb to affect the acoustical 
continuity of your program—in other words, to put differ-
ent sources of audio in the same room.

To use reverb in a clip, follow these steps.

	1.	 Add the Reverb effect to the clip (available for 5.1, 
stereo, or mono clips).

	2.	 Open the Fx Editor.

	3.	 Choose the presets that will most closely resemble the 
environment you want to duplicate:

.. Pre Delay. Specifies how long the sound will take to 
go from the originator of the sound to the virtual 
reflecting wall and back to the origin again.

Figure 4.35  A reverb is a room simulator that will 
help give your clips continuity.

You can use a DeEsser for more than 
just voice. You can control some of 
the frequencies produced by cym-
bals and snares, and even guitars!
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.. Absorption. Specifies how much of the sound will 
be absorbed by the material in the room.

.. Size. Specifies the size of the room (as a percentage).

.. Density. Specifies the number of reflections in an 
ambient space and is related to the size. High-densi-
ty values create rich-sounding reverbs.

.. Lo Damp. Specifies the amount of attenuation for 
low frequencies to preserve clarity.

.. Hi Damp. Specifies the amount of dampening of 
high frequencies.

.. Mix. Controls the amount of reverb.

Reverb practice

To better understand how the Reverb effect works, follow 
these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Reverb. 

	2.	 In the Audio Track Mixer, open the Fx Editor for the 
Reverb applied to the VO track.

	3.	 Play your Timeline, and as it plays, bypass the effect so 
you can get a clear idea of the before and after sound.

	4.	 Experiment with the presets and the settings to start 
training your ears to hear what reverb does for your 
audio.

Adobe Audition

Adobe Premiere Pro CC is powerful in that it can mix, 
adjust, and even clean up your audio, but it can’t replace a 
professional, audio, postproduction, digital audio worksta-
tion (DAW) like Adobe Audition (Figure 4.36). Sometimes 
you’ll need to mix and fix your audio in a professional 
audio environment. I’ll demonstrate two of my favorite 
solutions in Adobe Audition: removing noise and fixing 
clipped audio.
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Figure 4.36  Adobe Audition CC will help you process audio clips that are beyond Adobe Premiere Pro’s capabilities.

Removing Noise

Noise doesn’t always fit in a tidy frequency range notch, 
and it can be quicker, more effective, and much easier to 
fix your audio noise problem in Adobe Audition by using 
its effective, two-step, noise removal tool.

The process is to send a clip to Adobe Audition, select an 
area of the noise alone (without foreground audio) for 
Adobe Audition to “memorize,” and then select the entire 
clip to help it eliminate noise from the clip. What happens 
during this process is that Adobe Audition will generate 
the necessary signal to eliminate the noise and only the 
noise. To accomplish this task, follow these steps.

	1.	 Right-click on the clip you want to send to Adobe 
Audition, and choose Edit Clip in Adobe Audition 
(Figure 4.37). This command renders your clip and 
replaces your audio with a dynamically linked audio 
clip, and launches Adobe Audition with this clip open. 

Figure 4.37  Choose Edit Clip in Adobe Audition to 
repair noise in your clip.
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Adobe Premiere Pro will not send the original audio to 
Adobe Audition in order to preserve the original audio 
untouched, because any changes you make in Audition 
will permanently change this audio clip.

	2.	 Using the Audition Time Select tool (T), select a 
portion of the waveform that contains the noise but 
no dialogue.

	3.	 Right-click on the selected area, and choose Capture 
Noise Print (Figure 4.38). Alternatively, you can press 
Shift+P. Then deselect your selection on the audio 
waveform so that the next step will apply to the entire 
waveform, not just the sample audio selection.

Figure 4.38  In Adobe Audition, select the noise, right-click, and then choose Capture Noise Print. 
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	4.	 In the Effects menu, choose Noise Removal/Resto-
ration, and then select Noise Reduction (process) 
(Figure 4.39) to launch the Noise Reduction Effect 
panel. You can also access this panel by pressing 
Command+Shift+P (Ctrl+Shift+P). 

Figure 4.39  The Noise Reduction process in Adobe Audition is effective and 
easy to use. The best part is that you can send a copy of your audio clip directly 
to Adobe Audition from within Adobe Premiere Pro.

	5.	 Play your clip by clicking the play icon. Toggle the Ef-
fect Power State on and off as well as the Output Noise 
Only option while playing back the clip to further 
refine the noise reduction settings. 

	6.	 Click the Apply button. Adobe Audition likely does a 
pretty good job of removing the unwanted noise floor 
automatically, but you can make further adjustments by 
using a noise gate or an EQ.

	7.	 Save your changes by pressing Command+S (Ctrl+S), 
and return to Adobe Premiere Pro. Your audio file will 
update with the fixed audio.

Be sure to leave the Effect Power 
State on (green) and the Output 
Noise Only option off before you 
apply a change, or you’ll either 
apply no changes or output the 
noise only.
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Using Adobe Audition to remove background noise

To get a better understanding of how the noise removal 
process in Adobe Audition works, follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Audition Noise.

	2.	 On the Timeline, right-click the clip and choose Edit 
Clip in Adobe Audition.

	3.	 Once in Audition, select a part of the clip that contains 
only the background noise and nothing else (click and 
drag to select). You can even zoom in if you desire (press 
+). This selects the background noise for that clip. 

	4.	 Choose Effects > Noise Reduction / Restoration > Cap-
ture Noise Print (or press Shift+P).

	5.	 Click OK in the dialog that opens

	6.	 Click anywhere in the wave to deselect.

	7.	 Apply the effect by choosing Effects > Noise Reduction 
/ Restoration > Noise Reduction (process).

	8.	 When the panel opens, play the clip and move the slid-
ers until the room noise disappears. I used the values of 
92% for Noise Reduction and Reduce by 46dB.

	9.	 While the clip plays, bypass the effect so you can get a 
good idea of the before and after (toggle the effect off 
and on again) sound.

	10.	When you’re happy with the settings, click Apply and 
save your clip.

	11.	Go back to Adobe Premiere Pro; your clip is waiting for 
you there!

Fix Clipped Audio

As mentioned earlier, it’s best to record your audio prop-
erly to begin with than have to fix it in postproduction. 
However, sometimes you have no choice but to work with 
what you have. If you do need to fix a clip that is clipped, 
you can fix it somewhat using Adobe Audition CC. 

	1.	 Right-click the clip you want to send to Adobe Audi-
tion, and choose Edit Clip in Adobe Audition. This 

This noise removal process is 
amazing but it relies on there 
being a difference between the 
“room noise” and the sound you’re 
trying to keep in.
	 A conversation in front of an 
air conditioner? Fixable. In front of 
a coffeehouse where other people 
are talking? Probably the noise 
reduction won’t work.
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command renders and replaces your audio with a 
dynamically linked audio clip, and launches Adobe 
Audition with this clip open.

	2.	 In Audition, choose Window > Amplitude Statistics 
(Figure 4.40).

	3.	 Click the Scan button, and look at the Possibly Clipped 
Samples property to get a good idea of how much clip-
ping is in your clip. Using this value will let you set the 
correct preset when using the effect. (You will be able 
to determine if the clip is heavily or lightly clipped.)

	4.	 Choose Effects > Diagnostics > DeClipper (process) to 
open a new panel (Figure 4.41 on the next page).

	5.	 Choose the preset that best represents the amount of 
clipping in the clip. Experiment with different presets if 
you’re not sure.

	6.	 Click the Scan button.

	7.	 Click Repair All.

	8.	 Save your changes by pressing Command+S (Ctrl+S), 
and return to Adobe Premiere Pro. Your dynamically 
linked audio file will update with the fixed audio.

Figure 4.40  The Amplitude Statistics 
panel in Adobe Audition calculates 
statistics from an entire file or selection.

Disclaimer: Some clipped clips are 
unusable. Audition won’t be able 
to fix them.
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Using Adobe Audition to restore clipped audio

To get a better understanding of how to restore clipped 
audio, follow these steps.

	1.	 Open the project Chapter04_Audio.prproj, and then 
open the sequence named Audition DeClipper.

	2.	 On the Timeline, right-click the clip and choose Edit 
Clip in Adobe Audition.

	3.	 In Audition, choose Window > Amplitude Statistics to 
display the statistics and determine how much clipping 
is in the audio. This panel is for diagnostics only.

	4.	 Click the Scan button.

	5.	 Choose Effects > Diagnostics > DeClipper (process).

	6.	 When the panel opens, choose Restore Heavily Clipped 
and click the Scan button to identify which parts of the 
clips need to be fixed. A list of the problem areas ap-
pears at the bottom of the panel.

	7.	 Click Repair All and the effect will start working.

	8.	 Look at the waveforms when it is done. Much better, right? 

	9.	 Experiment with the settings; repeat the process over and 
over to get a good idea of how the effect works and what 
the settings do (you can use undo to reverse your changes).

	10.	When you’re happy with the settings, save your clip and 
return to Adobe Premiere Pro.

Figure 4.41  The DeClipper effect 
repairs clipped waveforms.
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Numbers
1:1 pixel mapping, seeing, 53
8 bits vs. 10 bits, 337
32 Bit Float Color Precision effect, 

285
720p60 broadcast standard, 91

Symbols
‘(accent) key, 7, 64, 138
\ (backslash) key, 138

A
accent (‘) key, 7, 64, 138
Activity Monitor, 31–32
Adjustment Layers bin, 99
adjustment layers, using, 292–294, 

386
Adobe After Effects. See After 

Effects, 27
Adobe Audition. See Audition
Adobe Creative Cloud.  

See also cloud
benefit, 17, 388
production process, 37
Sync, 17–21

Adobe Encore, installing, 452
Adobe Media Encoder. See Media 

Encoder
Adobe Photoshop. See Photoshop
Adobe Prelude. See Prelude
Adobe Story, 118–124
After Effects

composition naming, 108
Disk Cache, 108–110
Dynamic Linking, 107
effects, 39–40
frame sizes, 472–473
imported media, 110
learning, 44–45
Media Cache folder, 110
presets, 39–40
projects, 108
rendering for performance, 110
and SpeedGrade, 27

animating 
effects, 287–292
stills, 37

Animation codec, 415

Animation Presets, 39
Appearance preferences, 55
Apple ProRes reset, 80
archiving projects, 478–482
audio. See also clipped audio; dual 

capture sound; mixing sound; 
sound

adjusting levels, 92
Audition, 276–282
Clip Mixer, 260–261
Expand Audio Track, 245
feathering, 269
gain and levels, 240–244
headphones, 239–240
listening environment, 237–240
listening to recordings, 239
loudness, 240–244
matching to video, 234
merging, 90
nuances, 237
overcompressing, 268
replacing, 161–162
sound spectrum, 269
stereo vs. mono, 92–93
submixes, 264–265
syncing, 161–162
Timeline interface, 244–250
Track Mixer, 262–264
unlinking from video, 183
workspace, 240

audio channels, modifying, 93
Audio Clip Mixer, 260–261
audio clipping, 250–251
Audio FX

DeEsser effect, 274–275
DeHummer effect, 272–274
EQ (equalizer), 268–270
limiter, 268
Loudness Radar effect, 271–272
Multiband Compressor, 266–268
reverb effect, 275–276

audio levels, 254–255
audio master output, 82
audio mixing, 37
Audio preferences, 52
audio previews, 71
audio repair workflow, 37
audio scrubbing, 137–138
audio setup, 237–238
audio signal, receiving, 237

audio terminology, 244
Audio Track Mixer, 262–264
audio tracks

buttons, 246–248
dead, 95–96
keyframes, 248–249
locking, 200
naming, 250
resizing, 245
setting up, 81–82
using separately, 249

audio transitions, applying, 258
audio waveforms, viewing while 

trimming, 191
Audition

Amplitude Statistics, 281
back to Premiere Pro, 117
clips, 115
DAW (Digital Audio 

Workstation), 116
DeClipper effect, 282
destructive disadvantage, 474
disadvantage, 474–475
Disk Cache, 114–115
exporting tracks as stems, 117
fixing clipped audio, 280–282
learning, 43–44
removing noise, 277–280
restoring clipped audio, 280–282
sample-based noise reduction, 40
sequences, 116

auto save, 55, 72
Automate to Sequence, 155–160. 

See also sequences
AVC editing mode, 74
AVC IntraFrame codec, 414
AVCHD editing mode, 74
Avid DNxHD, 74, 414, 428, 430
Avid Media Composer

exporting AAFs, 12
importing from, 11
keyboard mapping, 65
media considerations, 12
translation, 12

B
background encoding, 38
backing up media, 28, 69–79
backslash (\) key, 138
backup project files, 119
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backups
manual in Project Manager, 

480–482
maximum number of, 70

Behance ProSite, 22
bin views, adjusting, 101–102
bins. See also projects

common types, 98–99
enlarging, 138
preference, 50
using as Source Monitor, 

155–160
black and white look, 381–382
buttons, 61

C
cache files, 56–58
caches

configuring, 27
directories, 105
system setup, 119

camera data, 454–455
camera formats, 4–7
camera logs, using, 225
camera media

maintaining, 455
system setup, 119
transferring, 455
vaulting, 455

camera raw files, 467–468
cameras

choosing for multi-camera 
editing, 234

professional, 4–5
chroma adjustments, 354–355, 400
chroma issues

fixing with RGB curves, 366
fixing with Three-Way Color 

Corrector, 359–360
chroma keying, 37
clipped audio, 251, 280–282. See 

also audio
clips. See also Fit Clip panel; 

footage; Reveal Clip; shots; 
Timeline clips

advice regarding unlinking, 50
editing from sequences, 220
grouping, 179
marking on fly, 137
merging and syncing, 89–90
merging based on audio, 89–90
merging based on metadata, 90
modifying for slow motion shots, 

90–92

naming, 99
relinking, 194–195
replacing, 164, 168
scrubbing, 137
unlinking, 194–195

cloud, 28. See also Creative Cloud
CMY colors, 338
codecs, 78–80, 84, 413–415, 464
Color Blend mode, 327
color correction, 37, 332–334, 

351, 356–357. See also light; 
primary corrections; secondary 
corrections; SpeedGrade

color correction interface setup
Combination views, 347
customizing, 347
full screen, 347
keyboard remapping, 350–351
modifying workspace, 348–350
RGB Parade, 345–347
tools, 340–341
vectorscope, 343–345
video scopes, 341
YbCr Parade, 347
YC Waveform, 341–343

color matching, 403, 405
Color Mattes bin, 99
color picker, using, 339
color temperature, 335
color wheel, 339
compositing and keying, 315, 

317–321
compression tips, 434
corrections vs. grades, 332
CPU, 24
crossfades, 257–258
Ctrl key. See keyboard shortcuts
cut points, selecting, 211–212

D
Darken Blend mode, 323
Darker Color Blend mode, 324
DeClipper effect, 282
DeEsser effect, 274–275
Default scale to frame size 

preference, 50−51
DeHummer effect, 272–274
Delete command, 172
deselection keyboard shortcut, 

65, 151
dialogue scenes, cutting, 162–163
digital storage, best practices, 455
digital-file output workflow, 37
Dissolve Blend mode, 323

distribution based codec, 413–414
Divide Blend mode, 327
DNxHD , 74, 414, 428, 430
DPX (Digital Picture Exchange), 

435, 476–477
drag-and-drop replace, 165–167
Dropped Frame indicator, 58–59. 

See also frames
dual capture sound, merging, 89. 

See also audio
DVCPro codec, 414
DVD-5 quick formula, 445
Dynamic Link, 327–330
dynamic trimming, 205–208. 

See also trimming

E
edit points, 211, 214–216
editing. See also multi-camera 

editing
adding shots to sequences, 137
Automate to Sequence, 155–160
back-timing, 151–152
basic assembly, 136–142
clips from sequences, 220
driving keyboard, 137
four-point, 152–154
JKL keys, 136
key commands, 136
keyboard as work surface, 

136–137
marking clips on fly, 137
modes, 74–77
moving frames, 137
navigating footage, 137
panel tabs, 129–130
Replace Edit, 168
saving workspace presets, 

130–133
scrubbing clips, 137
three-point, 143–145
Timeline, 131–135
tracks, 146–150
workflows, 37, 217–221
workspace layout presets, 

127–129
workspace setup, 127
zoom to sequences, 138

edits. See also split edit
Extract command, 170–172
insert and overwrite, 132
Lift, 169–170
toggling focus, 132
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effects
adjustment layers, 292–294
animating, 287–292
fixed, 286
Opacity Blend modes, 296–297
and presets, 39–40
reusing, 380
Rolling Shutter Repair, 303–304
saving, 380
scaling height and width, 297
standard, 286, 296
track mattes, 294–296
transitions, 291
Warp Stabilizer, 300–304

Effects tab, using for output, 417
Encore, installing, 452
EQ (equalizer) effect, 268–270
Export Media dialog box, 

420–426, 436–437
exporting 

media, 475–477
XML in Final Cut Pro, 9–10

exporting strategies
architectures, 409–415
AVI (Audio Video Interleaved), 

413
buckets, 412–413
client requests, 410–411
codecs, 409–415
Flash, 413
MP4 vs. h.264, 412
MPEG-4, 412
MXF (Materials eXchange 

Format), 413
needs vs. outputs, 410
output, 413–419
presets, 442–449
preview files, 427
QuickTime, 412
rendering while working, 427
uncompressed video, 409
video compression, 410

Extend Edit, 188–189, 200
external ports, upgrading, 35
Extract command, 170–172

F
file naming, 104
file-based cameras, 7
Final Cut Pro, 9–10, 65
final output, 426–430.  

See also output
Fit Clip panel, 152–156.  

See also clips

Flash 
architecture, 413
self-hosting preset, 446–448

flesh tones, adjusting, 370–372
folders, 69
fonts. See Title Designer
footage. See also clips

ingesting, 459
removing from Timeline, 

169–176
replacing, 164
transcoding, 457–458
transferring, 457–458

four-point editing, 152–153
frame size

decisions about, 465–467
restoring, 139

frames, 137−138. See also Dropped 
Frame indicator

G
gain, 240–244
Gaussian Blur effect, 314
General preferences, 49–50
GPU acceleration effect, 285
GPU cards, 26, 34
grades

vs. corrections, 332
turning on and off, 400

Gradient filter look, 383–384
grouping clips, 179, 195–197
Group-Selecting edit points, 

214–216

H
h.264 codec, 414, 431–434. See also 

output
hardware, 23, 30, 34–36
HDV editing mode, 75
headphones, 239–240
Hue Blend mode, 327
hum, 273–274

I
import

from Avid Media Composer, 11
to bins, 87
clips for slow motion shots, 

90–92
dead audio tracks, 95–96
dual sound, 89–90
“generic” projects, 97
vs. Media Browser, 86
merge and sync clips, 89–90

Prelude, 88–89
slow motion shots, 90–92
stereo vs. mono audio, 92–94

Import command, 86
In and Out range, marking for 

clips, 151
In points, designating, 458
ingesting footage, 37, 459
Input tracks, setting up, 83
insert edits, source patching for, 

146–149

J
JKL keys, 136, 139–140
JPEG (Joint Photograph Expert 

Group), 435

K
Kelvin units, 335
keyboard layout presets, saving, 

142–143
keyboard mapping

Adobe Premiere Pro, 64
Auto Waveform, 65
Avid Media Composer, 64
Deselect All, 65
Final Cut Pro 7.0, 65
increasing speed, 140
Media Browser, 66
modifying pre-mapped 

shortcuts, 140
panels, 65
preferences, 65
reclaiming unused keys, 140
tips, 141–142
Track Height Presets, 66

keyboard shortcuts
\ (backslash) key, 138
+ (plus) and − (minus), 139
Audio Channels option, 94
Copy command, 150
customizing, 140
Cut command, 150
deselection, 151
Effect Controls panel, 287
filling screen with video, 9
jumping to markers, 171
linking clips, 195
Match Frame, 169
maximize frame under cursor, 

138
modifying, 139–140
Paste command, 150
Replace Clip, 169
restore frame size, 139
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search box, 66
SpeedGrade, 393
Task Manager, 32
toggle full screen, 139
toggling trims, 211
trimming in Timeline, 187
unlinking clips, 195
workspaces, 62

keyframes, 256. See also track 
keyframes

keying, combining techniques, 
321–322

keying and compositing, 315, 
317–321

L
layers, 405
Lift edits, 169–170
light, 335–340. See also color 

correction
limiter, using, 268
linked selections, best practice, 50
list views with metadata, 

maximizing, 102–104
locking tracks, 200
.look files, 471
looks

adjustment layers, 386
applying across scenes, 386–387
black and white, 381–382
Bleach Bypass, 383
copying between shots, 402–403
described, 405
developing, 334, 380–381
filmic “S curve,” 381
Gradient filter, 383–384
Lumetri, 384–385
nesting, 387
recipes, 381
sepia, 382
summer, 383
summer + Grad filter, 384

looping, 44
LTO (Linear Tape Open) drive, 70
luma adjustments, 354, 397–400
luma issues, fixing, 358–359
Lumetri effect, 384–385, 388, 471

M
maintaining sync, 192–197. See also 

Sync Settings
markers, jumping to, 171
marquee-dragging, 214–216
masks, explained, 405

master tracks vs. submxes, 265
masters, 82–83
Match Frame, 160–163, 167–169
media

exporting, 475–477
rewrapped, 10–11

media backups, making, 69–79
Media Browser

directory viewers, 88
filtering by file type, 88
vs. import, 86
importing directly to bins, 87
JKL keys, 88
keyboard mapping, 66
playing through clips, 88
previewing media, 7–9
Thumbnail vs. List view, 87–88
viewing clips, 89

Media Cache folders, 57–58
Media Encoder

Add Output button, 439
adding metadata, 451
appearance, 451
Automatic Encoding preference, 

450
automating, 450–452
automating with watch folders, 

441
background encoding, 38
compression in Queue panel, 441
compression process, 438–439
custom transcode settings, 437
encoding, 438
interface, 438
learning, 41
locating media drives, 451
log information, 440
Media Cache folder, 111
MP3s for transcription, 452
naming system, 439
Output File Destination, 451
Output Preview area, 440
outputs/media, 111
overview, 437
preference adjustments, 450
Preset Browser, 440–442
presets, 438, 442-449
Queue button, 38
Queue panel, 438–439
resetting sources, 439
watch folders, 438, 441, 451–452, 

476
media setup, 67–69, 119–120
Memory preferences, 52
merging and syncing clips, 89

metadata views, 102–104
mezzanine formats, 464–465
mixing sound. See also audio

adding keyframes, 256
clipping, 251
crossfades, 257–259
DR (dynamic range), 251–254
level adjustment in Timeline, 

254–255
noise floor/room tone, 259
panning, 259–260
tracking keyframes, 256
using keyframes, 256
VU meters, 250

mono pair, adjusting to be stereo 
clip, 94

mono vs. stereo audio, 92–93
moves and trims, using numeric 

keypad for, 216
MP3s for transcription, 452
MP4 vs. h.264, 412
MPE (Mercury Playback Engine), 

14–16
MPEG-4 category, 412, 433
MTS-MPEG Transport Stream 

files, 13
multi-camera editing.  

See also editing
acquiring media, 223–227
adding sync markers, 231
adjusting, 233–234
building sequences, 230
choosing cameras, 234
keyboard mapping, 231
multi-camera sequences, 

228–232
organizing media, 227–228
performing, 232–233
preparation, 228–231
recording overlap, 226–227
recording sync marks, 225
selecting clips, 230
shooting wide, 227
sync timecode, 224–225
using camera logs, 226
video and matching audio, 234
workflow, 223–227

multichannel masters, 82–83
MXF (Materials eXchange 

Format), 413, 430
MXF DNxHD OP1a, 430
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N
nesting, using with looks, 387
Nests bin, 99
noise, removing, 277–280
noise floor/room tone, 259
noise reduction, 40
normalization methods, 244–245
numeric keypad, using for moves 

and trims, 216

O
online-hosting preset, 448–449
Opacity Blend modes, 296–297, 

323–327
Open CL architecture, 16
optimized setup. See also system 

setup
Appearance, 55
Auto Save, 55
cache files, 55–58
General, 49–50
Label Colors, 55
Memory, 52
Playback, 53
preferences, 48–49
Sync Settings, 53–54
Trim, 55

organization
adjusting bin views, 101–102
bins for projects, 98–99
clip naming, 100–101
list views and metadata, 102–104
sequence naming, 99

Out points, designating, 458
output. See also final output; h.264 

codec
accelerating, 427
Bars & Tone ID sequence, 419
clip names, 416
duplicating sequences, 415
Effects tab, 417
file size, 418
files, 420
monitoring, 30
naming sequences for, 415
nesting sequences, 417
timecode, 416
watermarking, 416–418

Outputs bin, 98
Overlay Blend mode, 325
Overlays, 59–60
overwrite edits, source patching 

for, 146–149

P
P2 cards, 3
P2 editing mode, 75
panels

enlarging, 138
keyboard mapping, 65
maximizing, 7

panning, 259–260
Paste Insert technique, 178–180
performance, keyboard mapping, 

65
Photoshop

best practices, 113–114
document setup, 112–113
documents, 112
documents for import, 113–114
Files/Graphics bin, 99
learning, 41–42
Merge options, 114
performance cache, 112
window layout with Timeline, 111

pixels, measuring with color 
picker, 339

Playback preferences, 53
playhead, adding, 404
PNG (Portable Network Graphic), 

435
Post codecs, 428
post/archival based codec, 413
poster frames, setting for shots, 

156
post-faders, 265
postproduction. See also Prelude

After Effects, 472–473
Audition, 473–475
camera raw files, 467–468
codecs, 464
fixing issues in, 222
frame size, 465–467
mezzanine formats, 464–465
Smart Rendering, 465
SpeedGrade, 468–473
starting in Premiere Pro, 456

pre-faders, 265
preferences, 49–55
Prelude. See also postproduction

Comment marker, 461
exporting to Premiere Pro, 463
features, 88–89
file renaming during ingest, 459
learning software, 42
markers, 460–462
media, 106–107
Media Cache folder, 106

metadata and file logging, 459
metadata during ingest, 459
In and Out points, 458
project cache, 105–106
projects, 105
Relink dialog, 459
rough cuts, 462
Subclip marker, 461
transcoding footage, 457–458
transferring footage, 457–458
Verification feature, 458

presets and effects, 39–40
previewing media, 7–9
previews, 119
primary colors, 336–337
primary corrections. See also color 

correction
SpeedGrade, 397–398
Three-Way Color Corrector, 352, 

357–363
production process in Adobe 

Creative Cloud, 37
Program panel, trimming in, 

187–192
project files, system setup, 119
Project Manager, 478–482
project setup

audio previews, 71–72
auto save, 72
captured video, 71
captures audio, 71
editing modes, 74–77
master templates, 85
optimizing, 70–71
sequence presets, 72–74
sequence template preset, 77–81
tracks, 81–85
video previews, 71–72

projects. See also bins 
archiving, 477
optimizing, 70–72

ProRes codec, 415, 428
prosumer cameras, 4–5

Q
Queue button, 436–437
QuickTime

advantage, 412
editing mode, 75
and Post codec, 426, 428–430

QuickTime media, 10
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R
RAID (Redundant Array of 

Information Disks)
explained, 28–29
upgrades, 35

RAID-5 backups, using, 29, 69
RAM

recommendations, 25
upgrades, 36

raw files, 467–468
raw footage

bin, 98
keeping versions of, 454–455

RED footage, maximizing 
performance, 26

RED Scarlet-X camera, 6
rendering, 427, 430. See also Smart 

Rendering
Replace Edit, 168
Resource Monitor, 7, 32–33
Retina MacBook, 35
Reveal Clip, 163–164. See also clips
reverb effect, 275–276
rewrapped media, 10–11
RGB color space, 336–337
RGB Curves, 351, 364–366
RGB Parade

Bright/Darks, 345–346
flesh tones, 346
neutral items, 345
SpeedGrade, 397

RGB processing, 364
Ripple and Roll, using in tandem, 

182–186
Ripple Delete command, 172–173
Ripple Edit tool, 182
Rolling Edit tool, 181–182
room tone, 259
rough cuts, creating, 462

S
S for snapping, toggling, 50, 186
Saturation Blend mode, 327
Scale to Frame Size workflow, 

217–219
scenes, combining, 220–221
script and speech technologies, 

118, 120–123
scriptwriting, 120–121
scrubbing clips, 137
SDCam codec, 414
secondaries, explained, 405

secondary corrections. See also 
color correction

eyedropper color selection, 
368–369

flesh tones, 370–372
key-based, 368
leaving single color, 374–375
refining selection, 369–370
shape-based, 375–377
Show Mask, 369
skies, 372–373
Soften control, 370
in Three-Way Color Corrector, 

352–353
Selection tool, 181
sepia look, 382
sequence presets, 72–77
sequence settings, Maximum 

choices, 80–81
sequence template presets

Apple ProRes, 80
audio master output, 82
building master template, 85
multichannel masters, 82
resaving presets, 77–78
smart rendering codecs, 78–80
split channel masters, 82–83
tracks, 81–82

sequence types, changing, 84
sequences. See also Automate to 

Sequence
adding shots to, 137
dragging, 82
editing clips from, 220
managing, 74
naming, 99
naming for output, 415
nesting, 417
zooming in, 138
zooming to, 138

shape-based corrections, 375–377
Shift key. See keyboard shortcuts
shortcuts. See keyboard shortcuts
shot matching, 377–379
Shot/Reverse shot, 402–403
shots. See also clips

adding to sequences, 137
replacing in timeline, 165–169
setting poster frames for, 156

skies, adjusting, 372–373
skin tones, adjusting, 370–372
Slide tool, 189–190
Slip tool, 189–190
slots, running out of, 36
Smart Rendering, 79–80, 465.  

See also rendering

snapping, toggling, 50, 186
Sony editing mode, 75
sort buttons effect, 285
sort index, forcing, 67
sound. See also audio

“brightness,” 238
“muddy,” 238
spectrum, 269

Source Monitor, using bin as, 
155–160

source patching, 146–149
speakers, 237–239
speech, smoothing, 50
speech and script technologies, 

118, 120–123
SpeedGrade. See also color 

correction
Add playheads, 393
adding playhead, 404
and After Effects, 27
AutoColorMatch, 405
chroma adjustments, 400
color correction, 390
color matching, 393, 403 405
Copy grade below mouse, 393
copying looks between shots, 

402–403
Direct Link, 471
Dynamic playback, 393
Export Look, 470
export options, 390
Final Saturation control, 401
Full screen toggle, 393
global controls, 401–402
Go to, 393
grading controls, 391
Input Saturation control, 401
keyframes, 406
layers, 391
Layers panel, 398
learning, 44–45
.look files, 471
Look preset filed, 118
luma adjustments, 398–400
LUTs (look-up tables), 118, 

469–470
Magenta control, 402
moving playhead, 392
navigating, 393
navigating Timeline, 392–393
Out points, 393
Pivot + Contrast control, 401
Play options, 393
playing clips, 393
In points, 393
preparing sequences, 390
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SpeedGrade (continued)
primary corrections, 398
range controls, 400–401
returning to Premiere Pro, 392
reviewing adjustments, 402
RGB Parade, 398
scope locations, 395–396
Send back to Adobe Premiere 

Pro, 390
Send to Adobe SpeedGrade, 390
shortcut keys, 393
Shot/Reverse shot, 402–403
show/hide options, 393
snapshots, 391, 406
Temperature control, 401
Timeline, 391
toggle Grading, 393
toggling In/Out points, 394
toolbar, 391
upstream from Premiere Pro, 

469–470
Vectorscope, 397
video cards, 27
viewer, 391, 395
Waveform, 396–397
workflows, 390
working directly in, 390
Zoom options, 393
zooming Timeline, 394

split channel masters, 82–83
split edit, creating quickly, 183. See 

also edits
SSD storage, 28, 35
standard effect rendering order, 

296
At Startup preference, 49
stereo vs. mono audio, 92–93
still frames, outputting, 435–436
Still Image Default preference, 50
storage

best practices, 455
caches, 27–28
choosing, 27
connections, 27
media, 28
OS considerations, 29–30
projects, 28
RAID, 28–29
SSD, 28

Story, 118–124
subclips, using, 100–101
submixes vs. master tracks, 264
Subtract Blend mode, 327

suite relations
After Effects, 107–110
Audition, 114–117
caches, 105
file naming, 104
media, 104–105
Media Encoder, 110–111
Photoshop, 111–114
Prelude, 105–107
SpeedGrade, 118

Swap Edit command, 176–178
sync, broken, 232
sync issues, repairing, 200
sync marks, recording, 225
Sync Replace, 167–169
Sync Settings, 53. See also 

maintaining sync
sync timecode, using, 224–225. See 

also Timecode
system design

computer monitor, 30
CPU, 24
hardware monitoring cards, 30
“minimum” configuration, 23
performance gains, 23
RAM, 25
storage, 27–30
Thunderbolt support, 23
video card, 26

system performance, 30–34
system setup, 119. See also 

optimized setup

T
tails

modified, 201–204
removing, 173–176

tape-based cameras, 7
Task Manager, 32
three-point editing, 143–146
Three-Way Color Corrector

fixing chroma issues, 359–360
fixing luma issues, 358–359
practicing with, 361–363
primary corrections, 352, 

357–363
ranges, 353
vs. RGB Curves, 361–363
secondary correction, 352–353
Tonal Range, 353

Thunderbolt connections, 27
TIFF (Tagged Image Foto 

Format), 435

Timecode, 416. See also sync 
timecode

Timecode Overlay, 425
Timeline

activating display indicators, 134
customizing tracks, 134
display settings, 132–133
fly-out menu, 135
Linked Selection, 192
live trimming on, 208–210
Match Frame, 160–163
removing footage, 169–176
removing footage from, 169–176
replacing footage, 164–165
replacing shots, 165–169
repositioning clips, 176–180
Reveal Clip, 163–164
saving track height preferences, 

133
scrolling, 131–132
Show Auto Keyframes, 135
trimming tips, 187
zooming, 131–132

Timeline clips. See also clips
Paste Insert technique, 178–180
repositioning, 176–179
Swap Edit command, 176–178

Timeline editing
asymmetrical trimming, 210–216
dynamic trimming, 205–208
Extend Edit live, 201
live trimming, 208
modified tops and tails, 201–204

Timeline Playback preference, 50
Title Designer

adjusting glow effect, 308
BRIKZ clip, 311
character spacing, 309–310
Custom Style Library, 305
effects and blends, 311–312
explained, 304–305
Gaussian Blur effect, 314
gradients, 310–311
kerning, 309–310
Lit property, 306
metallic styles, 305–307
nested sequence, 312–315
Title Properties panel, 306, 308
track matte, 312–315
tracking, 309–310
Typestyle 2, 307–308

Titles bin, 99
titling workflow, 37
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tools
Ripple Edit, 182
Rolling Edit, 181–182
Selection, 181
Slide, 190–191
Slip, 189–190

tops
modified, 201–204
removing, 173–176

track awareness, 146
track height preferences, saving, 

133
Track Height Presets, keyboard 

mapping, 66
track keyframes, 256.  

See also keyframes
track locks, 179
track mattes

using, 294–296
using with title effect, 312–315

track targeting, 150, 161
tracking, explained, 405
tracks

adjusting to be mono pair, 93
adjusting to ignore one, 94
customizing in Timeline, 134
locking, 200
naming, 82
setting up, 81–82

transcode settings, customizing, 
437

transcoding video
codecs, 457
considering, 15
vs. data transfers, 458
explained, 12–13
importing formats, 13
media handling, 14
performance, 14
portability, 14

transferring footage, 457–458
Transform effect, 286
transitions, using as effects, 291
Transparent Video bin, 99
Trim mode, 187–188
Trim preferences, 54–55
Trim tool cheat sheet, 188

trimming. See also dynamic 
trimming

asymmetrical, 210–214
dynamic and live, 208–210
Extend Edit, 188–189
Group-Select cuts, 214–217
maintaining sync, 192–200
in Program panel, 187–188
repairing sync issues, 200
Ripple and Roll, 182–186
Ripple Edit tool, 182
Rolling Edit tool, 181–182
Selection tool, 181
Slide tool, 190–192
Slip tool, 189–190
Tall Trim Jim, 216
tools, 181

trims, toggling, 211
trims and moves, using numeric 

keypad for, 216
TV, bins used in, 99
Typestyle 2, choosing, 307–308

U
Ultra Key, 315–319
Undo command, 179

V
VAR (Value Added Reseller), 34
VBR (variable bit rate), 431, 434
Vectorscope, 343–345, 397
Verification feature, using in 

Prelude, 458
video

legalizing, 387–388
switching with matching audio, 

234
transcoding, 12–14
unlinking audio from, 183

Video and Audio Transition 
preference, 49

video cards, 26, 35
video driver, updates to, 26
Video Limiter, 388
video previews, 71
video scopes, 341
video tracks, locking, 200

visible light spectrum, 335
volume level, adjusting for clips, 

254–255
VU meters, 250, 254

W
Warp Stabilizer, 300–304
watch folders. See Media Encoder
watermarking, 416–418
Waveform, 396–397
workflows

animating stills, 37
audio mixing, 37
audio repair, 37
Audition, 40
background encoding, 38
chroma keying, 37
color correction, 37
Default Scale to Frame Size, 51
digital-file output, 37
editorial, 37
effects, 39–40
handling camera data, 454–455
ingest, 37
learning curve, 38
multi-camera, 230
multi-camera editing, 222
Smart Rendering, 79–80
SpeedGrade, 390
Story, 122–123
titling, 37

workspaces, 61–62

X
XML, exporting in Final Cut Pro, 

9–10
XMP “sidecar” file, 459

Y
YbCr Parade, 347
YC Waveform, 341–343
YCr'Cb', 339–340
YUV space, 286, 339–340

Z
zooming in sequences, 138
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